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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for FOREST SERVICE, USDA for the reporting period [MARK REPORTING PERIOD]

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				FOREST SERVICE												REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				USDA

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Andrew Liebhold		Biogeographic Analysis of Historical Forest Insect Invasions and Host Associations		2/21/23				Sanntpoort-Noord, Netherlands		Swedish University of Agricultural Sciences (SUAS)						Common Carrier Local Transport.		x                  x				$1,150.00  $100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$800.00

				ST		SUAS		2/24/23		                    		2/21/2023-2/25/2023								Meals		x				$300.00

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Matthew Arvanitis		NLGA Visit - Demonstration of Lumber Testing Procedure		1/31/23				Merritt, BC		American Lumber Standard Committee (ALSC-NLGA)						POV				x		$200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,000.00

				Research Mathematical Statistician		ALSC-NLGA		2/2/23		                    		1/30/2023-2/3/2023								Meals				x		$300.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brian R. Sturtevant		Graduate Program's Seminar Series-the Ecology and Evolution Graduate Program		2/9/23				Brunswick, NJ		Ecology, Evolution & Natural Esources, Rutgers University (EENRRU)						Common Carrier Rental Car				x                 x		$1,000.00 $200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$410.00

				Research Ecologist		EENRRU		2/9/23		                    		2/8/2023-2/10/2023								Meals		x				$172.50

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brian R. Sturtevant		Landscape Ecology in Theory & Practice - Application to Federal Land Management		1/26/23				Northern Arizona University		Ecoanalytica, LLC						Common Carrier Rental Car		x                  x				$800.00    $300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$206.00

				Research Ecologist		Ecoanalytica, LLC		1/26/23		                    		1/25/2023-1/27/2023								Per Diem (at Gov Rate)		x				$185.00

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Miranda Mockrin		Site visit to Northern California for National Science Foundation		1/29/23				Lake, Butte, Sonoma Counties (Northern California)		University of Albany						Common Carrier Rental Car          Taxi/Shuttle		x                    x                  x		   		$963.00    $450.00    $150.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$794.00

				Research Scientist		University of Albany		2/4/23		                    		1/29/2023-2/4/2023								Per Diem (at Gov Rate)		x				$362.00

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Daniel R. Williams		Placemaking for Learning and Triving		3/6/23				Cambridge, MA		Harvard Graduate School of Education, Learning Innovations Laboratory (HGSE-LIL)						Common Carrier				x		$300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$250.00

				Research Social  Scientist		HGSE-LIL		3/4/23		                    		3/6/2023-3/8/2023								Taxi/Shuttle				x		$100.00

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Bengston		Todays Horticulture Symposium		2/3/23				PA		Professoinal Gardener's Alumni Association (PGAA)						Common Carrier Taxi/Shuttle        Travel Expenses		x                 x                 x				$392.00    $300.00     $$20.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Loidging		x				$129.00

				Research Economist		PGAA		2/3/23		                    		2/2/2023-2/3/2023								Meals		x				$64.00

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Grizelle Gonzalez De Jesus		29th Annual Conference of Yale Chapter of International Society of Tropical Foresters (ISTF)		2/2/23				New Haven, CT		Yale Chapter of the International Society of Tropical  Foresters						Common Carrier				x		$230.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$342.00

				Director		Leah Andino/Emma Grover		2/4/23		                    		2/1/2023-2/4/2023								Shuttle				x		$150.00

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Grizelle Gonzalez De Jesus		2023 ASABE International symposium on Socil Erosion Research under a Changing Climate		1/8/23				Puerto Rico		Americdan Society of Agricultural and Biological Engineers						Registration				x		$625.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Director		Jessical Bell/Dennis flanagan		1/13/23		                    		1/11/2023-1/13/2023								                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tamara Heartsill Scalley		Inaugural Workshop of the Collaborative Center for Landslides & Ground Failure Geohazards (IWCCLGFG)		1/8/23				Puerto Rico		Georgia Institute of Technology						Registration				x		$675.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Ecologist		Georgia Institute of Technology		1/13/23		                    		1/8/2023-1/13/2023								                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dustin Bronson		College of Forest Resources & Environmental Science Seminars Series		1/19/23				Houghton, MI		Michigan Technological University College of Forest Resources & Environmental Science (MTUCFRES)						Lodging				x		$98.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$88.50

				Researdch Plant Physiologist		MTUCFRES		1/19/23		                    		1/19/2023-1/20/2023								                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alex C. Wiedenhoeft		Department of Wood Science & Engineering Winter 2023 Seminar Series		1/11/23				Corvallis, Oregon		Oregon State University						Common Carrier				x		$850.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$196.00

				Research Botanist		Oregon State University 		1/11/23		                    		1/10/2023-1/12/2023								                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Lauren Redmore		Meta-Analysis of Lieterature on Women in Conservation		1/4/23				Brookings, SD		South Dakota State University						Common Carrier  Taxi/Shuttle				x                 x		$750.00    $200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$400.00

				Research Social  Scientist		South Dakota State University		1/7/23		                    		1/3/2023-1/7/2023								Meals				x		$200.00

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Peter Borissov kitin		Visiting Scientist Program by Tokyo Universityof Agriculture & Technology		12/12/22				Fuchu, Tokyo		Tokyo University of Agriculture & Technology (TUAT)						Common Carrier				x		$3,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$2,000.00

				Forest Products Technologist		TUAT		12/29/22		                    		12/10/2022-12/29/2022								Per Diem (at Gov Rate)		x				$1,740.00

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kristin Floress		Stakeholder Engagement in Natural Resources Planning		11/29/22				Purdue Univrsity Department of Horticulture & Landscape Architecture (PUDHLA)		PUDHLA						POV Mileage		x				$220.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Fuel		x				$75.00

				Research Social Scientist		PUDHLA		11/29/22		                    		11/28/2022-11/29/2022								Per Diem (at Gov Rate)		x				$96.00

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tamara Heartsill Scalley		Workshop of the Synthesis of Neotropical Tree Biodiversity with Plot Inventories		11/28/22				Montpellier, France		Foundationfor Research on Biodiversity & Center for Synthesis & Analysis of Biodiversity (CESAB)						Common Carrier				x		$1,300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$900.00

				Research Ecogolotist		FRB-CESAB		12/2/22		                    		11/26/2022-12/6/2022								Meals				x		$700.00

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				John M. Buffington		Seminar Presentation (Title of Seminar TBD)		11/3/22				Orono,ME		School of Earth & Climate Sciences, University of Maine (SECSUM)						                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Geomorphologist		SECSUM		11/6/22		                    		11/2/2022-11/7/2022								                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Andrew Liebhold		Swedish National Plant Protection Conference 2022		11/9/22				Uppsalal, SWEDEN		Swedish University of Agricultural Sciences (SUAS)						Common Carrier				x		$1,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$700.00

				Research Entomologist		SUAS		11/10/22		                    		11/7/2022-11/11/2022								                           

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Melody A. Keena		Annual Meeting, Entomological Society of America		11/13/22				British Columbia, Canada		Entomological Society of America						Common Carrier Lodging  		x                  x				$1,100.00 $1,045.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (at Gov Rate)		x				$355.00

				Research Entomologist		Entomologial Society of America		11/16/22		                    		11/12/2022-11/17/2022								Registration Fee				x		$495.00

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jessica Halofsky		Bi-Annual Mtg. of the Board on Agricultural & Natural Resources		12/5/22				WDC		National Academies of Sciences, Engineering and Medicine (NASEM)						Common Carrier Lodging              Meals				x                 x                 x		$500.00    $771.00    $56.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		x				$350.00

				Director, WWETAC & Northwest Climate Hub		NASEM		12/6/22		                    		12/4/2022-12/7/2022								Meals		x				$215.00

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christopher D. Oconnor		Wildland Fire Canada Conference		10/31/22				Canada		International Association of Wildland Fire						Common Carrier				x		$800.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$620.00

				Research Ecologist		International Association of Wildland Fire		11/4/22		                    		11/2/2022-11/4/2022								                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kristin Floress		School of Environment & Natural Resources Seminar Series		11/10/22				Ohio State University		Ohio State University School of Environment and Natural Resources (OSUSENR)						Common Carrier Lodging              Meals				x                 x                 x		$220.00    $244.00    $64.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Parking               Taxi/Shuttle		x                  x				$66.00     $60.00

				Research Social Scientist		OSUSENR		11/10/22		                    		11/9/2022-11/10/2022								Meals		x				$96.00

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Robert C. Venette		Upper Midwest Invasive Species Conference 2022		10/25/22				Green Bay, WI		University of Minnesota						Conference Fee				x		$450.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Biologist		Invasive Plant Association of Wisconsin		10/27/22		                    		10/24/2022-10/27/2022								                           

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Shelley Crausbay		Ute Mountain Ute Tribe Climate Adaptation Planning		10/25/22				Towaoc, CO		Stefan Tangen						Lodging				x		$134.24

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Climate Adpatation Specialist		Stefan Tangen		10/27/22		                    		10/24/2022-10/28/2022								                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeremy Fields		Community Leadership Institute		10/28/22				Charlotte, NC		Neighbor Works America						Common Carrier 				x		$659.70

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$315.00

				SEP/FPO		Neighbor Works America		10/29/22		                    		10/27/2022-10/30/2022								Tuition				x		$440.00

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Valerie E. Thompson		Colorado Trout Unlimited Rendezvous		10/21/22				Glenwood Springs, CO		Colorado Trout Unlimited						Lodging				x		$358.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				South Zone Fisheries Biologist		Colorado Trout Unlimited		10/23/22		                    		10/21/2022-10/23/2022								                           

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Humfredo Marcano-Vega		Mtg. of Network of National Forest Inventories of Latin America and the Carribbean		10/19/22				PanamaCity, Panama 		Food & Agriculture Organization of the United Nation (FAO)						Common Carrier				x		$800.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$519.00

				Research Biologist		FAO		10/20/22		                    		10/18/2022-10/21/2022								Meals				x		$300.00

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				John M. Buffington		Seminar Presentation (Title of Seminar TBD)		11/3/22				Orono, ME		School of Earth & Climate Sciences, University of Maine (SECSUM)						Common Carrier				x		$804.20

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$637.65

				Research Gemorphologist		School of Earth & Climat Sciences, University of Maine		11/6/22		                    		11/2/2022-11/7/2022								Meals				x		$190.00

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Suarez		Poultry Health Seminar		2/15/23				Jackson, MS		Mississippi Poultry Association						Lodging				x		$300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Leader		Mississippi Poultry Association		2/15/23		                    		2/14/2023-2/16/2023								                           

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				John Buffington		Seminar Presentation on Diagnostic tools for Stream Geomorphology		11/3/22				Orono, ME		University of Maine						Common Carrier				x		$804.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$637.65

				Research Gemorphologist		University of Maine		11/6/22		                    		11/2/2022-11/7/2022								Meals				x		$190.00

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jody  Tucker		2022 Wild Track Specialist Group Meeting		10/30/22				Portugal		WildTrack, Inc - nonprofit organization						Common Carrier				x		$1,600.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$480.00

				Biological Scientist		WildTrack, Inc-nonprofit organization		11/6/22		                    		10/29/2022-11/7/2022								Lodging				x		$800.00

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Travis Warziniack		Mtg. to address use of human values in conservation planning		10/24/22				Knoxville, Tennessee		University of Tennessee						Common Carrier				x		$500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$612.00

				Research Economist		University of Tennessee		10/28/22		                    		10/13/2022-10/29/2022								                           

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Therese M. Poland		Annual Meeting, Entomological Society of America		11/13/22				Canada		Entomological Society of America						Common Carrier		x				$1,100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (at Gov Rate)		x				$355.00

				Research Entomologist & Project Leader		Entomologial Society of America		11/16/22		                    		11/12/2022-11/17/2022								                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christel C. Kern		Irregular Shelterwood Systems Workshop		11/2/22				Ontario, Canada		Southern Ontario Section of Canadian Institute of Forestry (SOSCIF)						Common Carrier Lodging		x                 x				$1,000.00 $360.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Rental Car          POV				x                 x		$1,000.00  $320.00

				Research Forester		SOSCIF		11/3/22		                    		11/1/2022-11/4/2022								Per Diem (at Gov Rate)				x		$225.00

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Bruce G. Marcot		Collaboration with Australian government;Presentation to Murdoch University		11/7/22				Perth, Australia		Dept. of Primary Industries  & Regional Development, Western Australia (DPIRDWA)						Lodging				x		$2,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle				x		$250.00

				Research Wildlife Biologist		DPIRDWA		11/12/22		                    		11/5/2022-11/12/22								                           

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Bruce G. Marcot		Annual Conference of the Australasian Bayesian Newwork Modelling Society		11/13/22				Sydney, Australia		Annual Conference of the Australasian Bayesian Network Modelling Society (ACABNMS)						Lodging				x		$2,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle				x		$250.00

				Research Wildlife Biologist		ACABNMS		11/19/22		                    		11/13/2022-11/19/2022								                           

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Aaron Pina		13th Annual Ohio University Meterological Symposium		3/25/23				Ohio University, Athens, OH		Ohio University						Common Carrier				x		$392.40

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$246.34

				Bioclimatologist		Ohio University		3/25/23		                    		3/24/2023-3/26/2023								                           

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		90		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		91		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		93		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		94		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		95		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		96		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		97		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for APHIS, USDA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				APHIS										x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				USDA

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Cristobal Zepeda		Scientific Commission for Animal Diseases 		2/13/23				Paris, France		World Organization for Animal Health						Common Carrier				x		$2,500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (at Gov Rate)		x				$4,000.00

				APHIS Attache		World Organization for Animal Health		2/17/23		                    		2/11/2023-2/18/2023								Taxi/Shuttle		x				$300.00

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy T. Gilbert		Coordinating the development of Self-Disseminating Vaccines for Spillover Prevention		3/28/23				Stevenson, WA		University of Idaho						Common Carrier Taxi/Shuttle				xx		$330.00    $100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$608.00

				Supervisory Research Biologist		National Science Foundation		3/30/23		                    		3/27/2023-3/31/2023								Meals				x		$250.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Lisa Rochette		US Swine Health Improvement Plan General Conference Committee Working Group Meeting		12/20/22				Ames, IA		National Pork Board						Common Carrier				x		$600.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$288.00

				Assistant Director		Iowa State University		12/21/23		                    		12/19/2023-12/22/2023

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kathlen Hartment		Present a Good Aquacul.ture Practince Training Event		1/4/23				Kerala, India		University of Maryland's Joint Institute for Food Safety & Applied Nutrition (JIFSAN)						Lodging             Common Carrier				x                x		$1,200.00 $1,500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle       Meals		x                  x				$200.00    $500.00

				Senior Staff Veterinarian		JIFSAN		1/15/23		                    		1/5/2023-1/15/2023								Baggage            Concur Fee		x                  x				$60.00      $30.00

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Page E. Klug		Great Lakes EXPO Fruit, Vegetable and Farm Market		12/6/22				Grand Rapids, Michigan		Michigan State Horticultural Society & the Michigan Vegetable Council (MSHSMVC)						Common Carrier Taxi/Shuttle		x                  x				$1,200.00  $400.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$603.00

				Supervisory Resarch Wildlife Biologist		MSHSMVC		12/8/22		                    		12/5/2022-12/8/2022								Meals		x				$224.00

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Antoinette J. Piaggio		Foundation of the National Institutes of Health Gene Drive Research Forum		11/15/22				Brussels, Belgium		Foundation for the National Institutes of Health						Common Carrier Taxi/Shuttle				x                x		$2,000.00  $150.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$700.00

				Research Biologist		Foundation for the Natoinal Institutes of Health		11/16/22		                    		11/13/2022-11/20/2022								Meals				x		$300.00

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Viondette Lopez		SPS Trade Policy Director		11/14/22				United Arab Emirates, Dubai		U.S. Dairy Export Council						Common Carrier Lodging				x                x		$3,500.00 $2,310.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals                 Miscellaneous		x                  x				$1,260.00 $200.00

				SPS Trade Policy, Director		U.S. Dairy Export Council		11/17/22		                    		11/12/2022-11/19/2022								Airport Taxis		x				$400.00

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Delgado		Advisory Board Mtg. USDA NIFA Project		10/13/22				Burlington, VT		University of Vermont						Common Carrier				x		$200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$308.00

				Director		University of Vermont		10/14/22		                    		10/12/2022-10/14/2022								Per Diem (at Gov Rate)				x		$138.00

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Delgado		EUFMD Open Season 2022		10/26/22				Marseille, France		European Foot & Mouth Disease (EUFMD)						Common  Carrier				x		$1,100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,500.00

				Director		EUFMD		10/28/22		                    		10/24/2022-20/29/2022								Registration				x		$250.00

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeff Carpenter		National Association of Truck Stop Owners (NATSO)		3/8/23				Grapevine, TX		NATSO						Registration Fee				x		$1,599.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				HBIIP Manager		NATSO		3/10/23		                    		3/7/2023-3/10/2023								                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeff Carpenter		17th Ethanol: Emerging Issues Forum		3/6/23				Omaha, NE		N/A						Registration Fee				x		$150.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				HBIIP Manager		N/A		3/7/23		                    		3/6/2023-3/6/2023								                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alice Porco		Mtg. with University of Virgin Island, USDA APHIS Wildlife Services & National Park Service		3/22/23				St. John, VI		Virgin Islands Department of Health						Sea Plane				x		$250.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$200.00

				Veterinary Medical Officer		Esther Ellis		3/23/23		                    		3/22/2023-3/23/2023								                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		78		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		79		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		80		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		81		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		82		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		83		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		84		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		85		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		86		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		87		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		88		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		90		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		91		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		93		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		94		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		95		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		96		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		97		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           





																																Internal OGE Use Only



																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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																				OGE Form-1353
(OGE-Approved Alternative for SF-326)
February 2011





		1353 Travel Report for REE, USDA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				REE										x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				USDA

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sandra Hoffmann		4th Mtg. of the WHO Foodborne Disease Burden Epidemiology Reference Group		11/15/22				Geneva, Switzerland		World Health Organization						Common Carrier				x		$1,200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$830.00

				Economist		World Health Organization		11/17/22		                    		11/11/2022-11/18/2022								Per Diem(gov Rate)				x		$835.00

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    										                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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																																Internal OGE Use Only



																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for , NRCS for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

														X		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				NRCS

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kennard Williams		Young Southeast Asian Leaders Initiative Professional Fellow Program		3/3/23				Philippines		American Councils for International Education						Common Carrier				x		$1,600.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$700.00

				District Conservationist		American Concils for International Education		3/16/23		                    		3/1/2023-3/17/2023								Taxi/Shuttle				x		$140.00

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chen-Lun Chang		Convening of the African Capacity Building Foundation		2/6/23				Italy		Rockefeller Foundatoin						Transportation				x		$228.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,152.00

				Program Analyst		Rockefeller Foundation		2/10/23		                    		2/5/2023-2/8/2023								Meals				x		$550.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tiffany L. Carter		Plant Science Department Seminar		10/21/22				State College, PA		PA State University, Department of Science (PSUDPS)						Common Carrier				x		$1,772.55

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$260.00

				Research Soil Scientist		PSUDPS		10/21/22		                    		10/20/22-10/22/2022

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    										                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for , FAS for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

														x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				FAS

				Agency Contact:				andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Andrew G. Stephens		Pack Expo International		10/23/22				Chicago, IL		Packaging Machinery Manufacturing Institute (PMMI)						Regisgration Fee				x		$130.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Neak				x		$40.00

				Senior Policy Advisor		PMMI		10/25/23		                    		10/23/2022-10/26/2022

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ernest Carter		Biodiesel Conference		11/15/22				Buenos Aires, Argentina		Evonik Metilatos SA						Common Carrier 				x		$4,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$750.00

				Agriculture Economist		Evonik Metilatos SA		11/16/22		                    		11/11/2022-11/28/2022								Taxi/Shuttle				x		$75.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Heidi Broekemeier		FERMA Fair, Polish Federation of Cattle Breeders & Milk Producers/Dairy Farmers Forum on Energy & Prices & Dairy Industry (PFCB&MP/PFCBDF)		2/24/23				Bydgoszcz, Poland		PFCB&MP/PFCBDF						lODGING				X		$66.73

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Agricultureal Attache		(PFCB&MP/PFCBDF)		2/25/23		                    		2/24/2023-2/25/2023

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Megan Francic		Visit to Meghna Group Soy Crushing Facility		2/28/23				Naratabgibhm Babgkadesg		Meghna Group of Industries						Transportation by Helicopter				x		$3,338.35

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Agricultural Attache		Meghna Group of Industries		2/28/23		                    		2/28-2023-2/28/2023

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    										                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for RURAL DEVELOPMENT, USDA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				RURAL DEVELOPMENT										x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				USDA

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Karama Neal		2023 Annual Meeting of Investors, Prairie Harvest 2022		10/5/22				Denver, CO		Open Prairie						Lodging				x		$275.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Administrator		Open Prairie		10/6/22		                    		10/5/2022-10/6/2022

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Bill Sheppard		2023 Ethanol: Emerging Issues Forum		3/6/23				Omaha, NE		N/A						Registration Fee				x		$150.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Business Programs Specialist		N/A		3/7/23		                    		3/6/2023-3/6/2023

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Wilson		KRBA Spring Meeting		3/28/23				Lexington, KY		Kentucky Rural Broadband Assoc. (KRBA)						Registration Fee				x		$249.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				GFR		KRBA		3/29/23		                    		3/28/2023-3/29/2023

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dr. Sharese C. Paylor		NRLA'S 8th Annual USDA Lenders Conference		10/19/22				WDC		Pam Wilcher Moore						Registration Fee				x		$995.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Civil Rights Director		Pam Wilcher Moore		10/19/22		                    		10/18/2022-10/19/2022

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    										                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for ARS, USDA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				ARS										x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				USDA

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kristen Brady		Incubation & Fertility Research Group Annual Meeting		10/13/22				Oegstgeest, Netherlands		Incubation & Fertility Research Group						Lodging				x		$453.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meal				x		$45.82

				Researdch Physiologist		The World's Poultry Science Association		10/14/22		                    		10/121/2022-10/15/2022

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeff Herrick		United Nations Environment Programme International Resource Panel		10/17/22				Paris, France		United Nations Environmnet Programme International Resource Panel (UNEPIRP)						Common Carrier				x		$1,500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$1,089.00

				Research Soil Scientist		UNEPIRP		10/20/22		                    		10/16/2022-10/20/2022								Per Diem (Gov Rate)		x				$550.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jacqueline Serrano		2022 Entomological Society of America		11/13/22				Canada		Entomological Society of America						Lodging             Conference Reg.				x                 x		$1,000.00 $355.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Mileage              Parking		x                 x				$350.00    $300.00

				Research Entomologist		Entomological Society of America		11/16/22		                    		11/11/2022-11/17/2022								Per Diem (Gov Rate)		x				$300.00

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Perishih Liang		2nd. Research Coordination Mtg. on Innovating RadiationProcessing of Food with Low Energy Beams from Machine Sources		10/10/22				Vienna, Austria		International Atomic Energy Agency (IAEA)						Common Carrier				x		$1,800.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,200.00

				Research Agricultural Engineer		IAEA		10/14/22		                    		10/7/2022-10/17/2022								MISC.				x		$600.00

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dong Cha		Phytosanitary Research Symposium		10/22/22				Korea		Animal & Plant Quarantine Agency						Common Carrier				x		$1,800.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,200.00

				Research Biologist		Animal & Plant Quarantine Agency		10/29/22		                    		10/21/2022-10/30/2022								MISC.				x		$800.00

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Raymond K. Yokomi		14th International Citrus Congress		11/6/22				Mersin, Turkey		14th International Citrus Congress						Common Carrier Lodging		x                 x				$2,000.00$1,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration		x				$550.00

				Reasearch Plant Pathologist		14th International Citrus Congress		11/12/22		                    		11/4/2022-11/12/2022								Meals		x				$220.00

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Robert R. Krueger		2nd.International Date Palm Forum		11/9/22				Sonora, Mexico		Sonora State University						Common Carrier		x				$100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$700.00

				Suvy Res Horticulturist		Sonora State University		11/13/22		                    		11/8/2022-11/14/2022								Meals		x				$200.00

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manuel Borca		Workshop on Diagnostic Techniques for Tranasboundary Animal Diseases		10/17/22				`		International Atomic Energy Agency (IAEA)						Common Carrier		x				$1,287.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,345.00

				Microbiologist		IAEA		10/21/22		                    		10/15/2022-10/22/2022								Meals				x		$675.00

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Benjamin M. Rosenthal		Solving Problems in Animal Health & Food Safety caused by Parasites of Livestock		10/10/22				Paris, France		Ecole Nationale Veteranerie d'Alfort						Common Carrier Train from Bern, Switzerland to Paris		x                 x				$90.00      $90.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$600.00

				Supervisory Zoologist		Ecole Nationale Veteranerie d'Alfort		10/12/22		                    		10/8/2022-10/13/2022								Meals		x				$210.00

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary J. Pantin-Jackwood		National Mtg. on Poultry Health, Processing & Live Production		10/3/22				Ocean City, Maryland		Delmarva Chicken Association (DCA)						 Rental Car          Registration		x                 x

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Veterinary Medical Officer		DCA		10/5/22		                    		10/3/2022-10/5/2022								                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alanna Moshfegh		22nd International Congress of Nutrition		12/6/22				Tokyo, Japan		Hisanori Kato, Ph.D.. Chair 22nd International Congress of Nutrition Organizing Committee						Common Carrier		x				$2,669.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$1,052.00

				Research Leader		Hisanori Kato, Ph.D.		12/11/22		                    		12/4/2022-12/11/2022								Registration		x				$588.00

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Wendy M. Sealey		World Ethanol and Biofuels		11/8/22				Brussels, Belgium		Informa Connect						Lodging		x				$1,650.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration World Biofuels		x				$2,000.00

				Research Physiologist		Informa Connect		11/10/22		                    		11/4/2022-11/11/2022								Registration		X				$900.00

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Hepler		Entomological Society of Canada & British Columbia Joint Meeting		11/13/22				Vancouver, Canada		Entomological Society of America						Common Carrier  Lodging		x                 x				$1,300.00 $776.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		x				$330.00

				Research Entomologist		Entomological Society of America		11/16/22		                    		11/12/2022-11/17/2022								Registration		x				$695.00

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David E. Swayne		XX National Poultry Congress		11/2/22				Medellin, Columbia		National Association of Poultry Farmers of Columbia (NAPFC)						Common Carrier		x				$1,200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$435.00

				Laaboratory Director		NAPFC		11/4/22		                    		11/1/2022-11/4/2022								Meals		x				$312.00

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gayle Volk		Breathing New Life into thte Global Crop Conservation Strategies		11/28/22				Bonn, Germany		Global Crop Diversity Trust						Common Carrier Taxi/Shuttle				x                 x		$1,500.00 $200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$591.00

				Plant Physiologist		Global Crop Diversity Trust		11/29/22		                    		11/26/2022-11/30/2022								Meals				x		$495.00

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jaya Shankar Tumuluru		Pro2BE - Research Collaboration Meeting		11/28/22				Karlstad, Sweden		Karlstad University, Karlstad, Sweden						Common Carrier		x				$1,500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (Gov Rate)		x				$700.00

				Res. Agricultural Engineer		Karlstad University, Karlstad, Sweden		12/2/22		                    		11/26/2022-12/3/2022								                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gayle Volk		Breathing New Life into thte Global Crop Conservation Strategies		11/28/22				Bonn, Germany		Global Crop Diversity Trust						Common Carrier Taxi/Shuttle        Train		x                 x                  x				$1,500.00 $110.00    $100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$591.00

				Plant Physiologist		Global Crop Diversity Trust		11/29/22		                    		11/26/2022-11/30/2022								Meals		x				$495.00

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Hans H. Cheng		Plant and Animal Genome		1/13/23				Sandiego, CA		International Plant & Animal Genome 30						Common Carrier		x				$500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$1,000.00

				Research Geneticist		International Plant & Animal Genome 30		1/18/23		                    		1/13/2023-1/18/2023								Registration		x				$845.00

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Philipp Simon		Plant and Animal Genome Meeting-PAG 30		1/13/23				San Diego, CA		Scherago Int'l. - Orgaizer of PAG 30						Common Carrier				x		$250.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$511.00

				Research Geneticist		Scherago Int'l.-Orgaizer of PAG 30		1/18/23		                    		1/12/2023-1/19/2023								Registration				x		$845.00

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joseph E. Munyaneza		AeroFarms 2nd AgTech Innovation Summit		2/14/23				Abu Dhabi, United Arab Emirates		AeroFarms, Inc						Common Carrier		x				$2,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$1,000.00

				National Program Leader		AeroFarms, Inc.		2/17/23		                    		2/13/2023-2/19/2023								Meals		x				$800.00

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Paulo C. Reis Vieira		Improve Moleculqr & Methodologies to Identify & Prediction of new Nematode Outbreaks		3/16/23				University of Brasilia		Brazilian Federal Agencyfor Support & Evaluation of Graduate Eduction						Common Carrier Lodging/Meals				x                 x		$936.00    $2,595.91 

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Health Insurance				x		$74.17

				Research Molecular Biologist		Prof. Thais Ribeiro Santiago & Prof. Danilo Batista Pinho		3/31/23		                    		3/15/2023-3/31/2023								Settling Allowance				x		$407.93

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dennis Hancock		Tour de Forage		1/24/23				Rochester, MN		Midwes Forage Assoc.						Lodging				x		$387.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Center Director		Midwes Forage Association		1/26/23		                    		1/23/2023-1/26/2023								                           

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Terry Lane Griswold		Bee Identification Workshop		1/25/23				Kampala, Uganda		Makerere University						Common Carrier Taxi/Shuttle				x                 x		$1,600.00$100.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,200.00

				Research Entomologist		Makerere University		2/4/23		                    		1/22/2023-2/5/2023								Meals				x		$770.00

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Moon S. Kim		Seminar on Sensing & instrumentation technology development for food safety		3/7/23				Kangwon National University		Gangwon National University						Common Carrier				x		$4,500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle				x		$100.00

				Research Leader		Gangwon National University		3/14/23		                    		3/5/2023-3/15/2023C								                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James J. Giovannoni		Gene Editing for Improved Fruit quality and nutrition		1/28/23				Puerto Rico		Inter American University of Puerto Rico						Common Carrier Taxi/Shuttle				x                 x		$870.00    $125.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$477.00

				Molecular Biologist		Inter American University of Puerto Rico		1/30/23		                    		1/28/2023-1/31/2023								Meals				x		$240.00

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sharon Drumm		2022 Fall Commencement Ceremony of North Carolina State University		12/16/22				Raleigh, North Carolina		North Carolina State University (NCSU)						Lodging             Taxi/Shuttle        Meals				x                x                 x		$800.00    $$150.00   $43.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier		x				$934.20

				REE Senior Advisor		NCSU		12/17/23		                    		12/15/2023-12/17/2023								Registration Transportation		x                  x				$39.45      $60.00

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manan Sharma		2023 International Assoc. Food Protection Program Committee Mtg.		2/17/23				Canada		International Association for Food Protection						Common Carrier Parking				x                 x		$500.00   $80.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$675.00

				Research Microbiologist		International Association for Food Protection		2/18/23		                    		2/16/2023-2/19/2023								Meals				x		$225.00

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gennaro Fazio		Apple rootstock field trials & VII field day on rootstocks from Geneva in Brazil		1/15/23				Caxias do Sul-RS, Vacaria, RS, & Lages, SC		Agromillora Producao E Comercio De Mudas Vegetais (APECDMV)						Common Carrier		x				$3,000.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$500.00

				Research Geneticist		APECDMV		1/20/23		                    		1/14/2023-1/20/2023								Meals				x		$200.00

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David E. Swayne		13th Symposium Poultry Production		11/30/22				Ankara, Turkey		Turkish Branch of the World veterinary Poultry Association (TBWVPA)						Common Carrier				x		$1,413.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$486.00

				Laaboratory Director		TBWVPA		12/1/22		                    		11/28/2022-12/2/202								Meals				x		$248.00

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Keith Fuglie		Policy Seminar on Agricultural Productivity		12/9/22				London, United Kingdom		Agricultural Economics Society of the United Kingdom (AESUK)						Common Carrier				x		$1,300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$900.00

				Research Entomologist		AESUK		12/9/22		                    		12/8/2022-12/11/2022								                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Charles Burks		IAEA Mtg. Develop the Thematic Plan for Lepidoptera		2/6/23				Vienna, Austria		International Atomic Energy Agency (IAEA)						Common Carrier				x		$1,300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,827.00

				Research Entomologist		IAEA		2/10/23		                    		2/4/2023-2/11/2023								Per Diem (Gov Rate)				x		$798.00

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Lindsay Allen		Micronutrient Forum Program Development Subcommittee Meeting		1/19/23				WDC		Micronutrient Forum						Common Carrier Taxi/Shuttle  Meals		x                 x                  x				$500.00    $200.00     $312.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$340.00

				Research Physiologist		Micronutrient Forum 		1/20/23		                    		1/18/2023-1/21/2023								Parking/Airport   Mileage to Airprt		x                  x				$68.00      $25.00

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Doreen H. Ware		ELIXIR Scientific Advisory Board Mtg.		2/14/23				Cambridge, UK		ELIXIR Scientific Advisory Board						Common Carrier		x				$1,300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle       Lodging				x                 x		$200.00    $996.00

				Researach Molecular Biologist		ELIXIR Scientific Advisory Board 		2/16/23		                    		2/13/2023-2/17/2023								In-Country Transfers				x		$200.00

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				 Douglas Gladue		Tawan Conference on Carbon Neutral Agriculture		3/6/23				Tainan, Taiwan		Council of Agriculture (COA)						Common Carrier				x		$7,233.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$890.00

				Microbiologist		COA		3/9/23		                    		3/5/2023-3/10/2023								Taxi/Shuttle				x		$328.00

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manuel Borca		Tawan Conference on Carbon Neutral Agriculture		3/6/23				Tainan, Taiwan		Council of Agriculture (COA)						Common Carrier				x		$7,233.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$890.00

				Microbiologist		COA		3/9/23		                    		3/5/2023-3/10/2023								Taxi/Shuttle				x		$328.00

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joseph M. Bosilevac		Shaping the Future, Risk-based meat inspection and Integrated Meat Safety Assurance		3/29/23				Romania		Risk, based meat inspection and integrated meat safety assurance (RIBMINS)						Common Carrier		x				$1,631.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (Gov Rate)		x				$385.00

				Research Microbiologist		RIBMINS		3/30/23		                    		3/27/2023-3/31/2023								                           

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Suarez		Poultry Health Seminar		2/15/23				Jackson, MS		Mississipi Poultry Association (MPA)						Lodging				x		$300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Leader		MPA		2/15/23		                    		2/14/2023-2/16/2023								                           

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Susan A. O'Shaughnessy		BARD 2023 Technical Advisory Committee Mtg.		3/27/23				Kibbutz Kfar Giladi, Galil Elyon 122100		Binational Agridcultural Research & Development Fund (BARDF)						Common Carrier  Taxi/Shuttle        Parking		x                  x                 x                   				$3,000.00 $$200.00  $60.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,830.00

				Agriculture Engineer		BARDF		3/29/23		                    		3/25/2023-3/30/2023								Per Diem (Gov Rate)		x				$772.00

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Yniv Palti		Annual Mtg. of US and Israeli BARD TAC (BARD-TAC)		3/27/23				Israel		BARD-TAC						Common Carrier Taxi/Shuttle    Parking              Mileage              TMC Transaction 		xxxxx				$1,353.77    $300.00      $140.00        $65.00         $28.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$740.00

				Research Geneticist		BARD-TAC		3/29/23		                    		3/25/2023-3/31/2023								Per Diem (Gov Rate)		x				$,254.00

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Lindsay		Food Safety with Chungnam		3/7/23				Daejeon, South Korea		College of Agridulture & Life Science, Chungnam National University (CALSCNU)						Common Carrier				x		$6,685.05

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$250.00

				Senior National Program Leader		CALSCNU		3/10/23		                    		3/5/2023-3/11/2023								Lodging				x		$1,000.00

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gregory W. McCarty		US-Taiwan Conf. on Carbon Neutral Agriculture		3/5/23				Taipei Taiwan		Tiawan Department of Science of Technology						Common Carrier Taxi/Shuttle				x                 x		$7,233.00 $$330.00																		Tiawan Department of Science of Technology

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$830.00

				Research Soil Scientist		Taiwan Council of Agriculture		3/10/23		                    		3/3/2023-3/11/2023								Meals				x		$370.00

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ben Gutierrez		Global Strategy for the Conservation & Us of Fruit Tree Genetic Resources		1/30/23				Benevento, Italy		DiCo VaLe Project						Common Carrier				x		$1,000.00																		DiCo VaLe Project

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,500.00

				Geneticist/Curator		DiCo VaLe Project		1/31/23		                    		1/27/2023-2/1/2023								Taxi//Shuttle				x		$200.00

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joseph Kozlovac		USDA ARS/ABSA 7th International Biosafety & Biocontainment Symposium		2/6/23				Baltimore, MD		American Biological Safety Association (ABSA)						Lodging				x		$548.00																		American Biological Safety Association (ABSA)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$114.00

				Biological Scientist		ABSA		2/9/23		                    		2/9/2023-2/9/2023								                           

		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Clint Mattox		59th Annual WCTA Conference and Trade Show		2/15/23				River Rock Casino, Richmond, BC, Canada		Western Canada Turfgrass Association (WCTA)						Common Carrier Taxi/Shuttle 		x                 x				$641.35    $150.00																		Western Canada Turfgrass Association (WCTA)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$856.00

				Research Weed Scientist		WCTA		2/17/23		                    		2/14/2023-2/18/2023								Meals		x				$605.00

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joseph E. Munyaneza		62nd World Vegetable Center Board of Directors Meeting		11/13/22				Bangkok, Thailand		World Vegetable Center						Common Carrier				x		$1,700.00																		World Vegetable Center

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$1,000.00

				National Program Leader		World Vegetable Center		11/18/22		                    		11/11/2022-11/19/2022								Meals				x		$600.00

		46		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chavonda Jacobs-Young		37th Small Farms Week Appreciation Luncheon		3/29/23				Greensboro, NC		North Carolina A&T State University						Lodging             Taxi/Shuttle        Meals				x                x                x		$250.00    $100.00    $16.00																		North Carolina A&T State University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier Taxi/Shuttle      Meals		x                   x                 x 				$500.00    $100.00    $100.00

				Chief Scientist		North Carolina A&T State University		3/29/23		                    		3/28/2023-3/29/2023								Grnd Transportation 		x				$160.00

		47		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michael J. Sharon		IAEM Conference Presentation Review		3/13/23				Colorado Springs, CO		International Associatoin of Emergency Managers						Lodging             Meals				x                 x		$363.00    $138.00																		International Associatoin of Emergency Managers

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem (Gov Rate)		x				$103.50

				Chief, Emergency Programs Division		International Association of Emergency Managers		3/15/23		                    		3/13/2023-3/16/2023								Common Carrier Taxi/Shuttle		x                 x				$961.41    $70.00

		48		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chavonda Jacobs-Young		2022 Fall Commencement Ceremony of North Carolina State University		12/16/22				Raleigh, North Carolina		North Carolina State University (NCSU)						Lodging              Taxi/Shuttle        Meals				x                 x                 x		$1,200.00  $150.00   $43.00																		North Carolina State University (NCSU)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier Grnd. Transp.		x                 x				$841.86    $160.00

				Chief Scientist		North Carolina State University		12/17/23		                    		12/15/2023-12/19//2023								Meals/4 Guest    Parking/4 Guest				x                x		$132.00    $80.00

		49		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Keevin Hackett		Envisioning a Biological Collections Action Center		3/23/23				New York Botanical Gardens		IiDigBio						Lodging		x				$515.00																		IiDigBio

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										POV				x		$240.00

				National Program Leader		iDigBio		3/24/23		                    		3/22/2023-3/25/2023								                           

		50		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Edward S. Buckler,IV		Advances in Genome Biology and Technology Meeting 2023		3/26/23				San Antonio, Texas		International Maize & Wheat Improvement Center (CIMMYT)						Registration (all accommodations included in this fee)				x		$1,650.00																		International Maize & Wheat Improvement Center (CIMMYT)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Geneticist		CIMMYT		3/29/23		                    		3/25/2023-3/31/2023								                           

		51		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chavonda Jacobs-Young		37th Small Farms Week Appreciation Luncheon		3/29/23				Greensboro, NC		NC A&T State University						Common Carrier Taxi/Shuttle       Grnd. Transp.    Meals 		x                 x                 x                 x				$500.00    $100.00    $100.00    $100.00																		NC A&T State University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging             Meals				x                 x		$225.00    $16.00

				USDA Chief Scientist		NC A&T State University		3/29/23		                    		3/28/2023-3/29/2023								Taxi/Shuttle				x		$100.00

		52		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary J. Pantin-Jackwood		National Mtg. on Poultry Health, Processing & Live Production		10/3/22				Ocean City, Maryland		Delmarva Chicken Association (DCA)						Lodging              Meals				x                 x		$212.00     $172.50																		Delmarva Chicken Association (DCA)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				x		$225.00

				Research Veterinary Medical Officer		Delmarva Chicken Association		10/5/22		                    		10/3/2022-10/5/2022								Common Carrier		x				$253.51

		53		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Vincent Baker		Immunology & Microbiology Departmental Seminar		3/31/23				Aurora, Colorado		University of Colorado						Common Carrier				x		$300.00																		University of Colorado

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$150.00

				Research Veterinary Medical Officer		University of Colorado		3/31/23		                    		3/30/2023-3/31/2023								                           

		54		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Travis Warziniack		NBER CRIW Conference on Measuring & Accounting for Environmental Public Goods		3/16/23				Arlington, VA		National Bureau of Economic Research (NBER)						Common Carrier		x				$500.00																		National Bureau of Economic Research (NBER)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$239.00

				Research Economist		NBER		3/17/23		                    		3/15/2023-3/18/2023								Per Diem (Gov Rate)		x				$280.00

		55		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		56		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		57		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		58		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		59		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		60		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		61		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		62		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		63		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		64		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		65		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		66		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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		67		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		68		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		71		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		72		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		73		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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																				OGE Form-1353
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		1353 Travel Report for , FSIS for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

														x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				FSIS

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brycre Carson		16th Dubai International Food Safety Conference		11/1/22				Dubai World Trade Center		Dubai Municipality						Common Carrier Taxi/Shuttle				x                 x`		$2,000.00 $40.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging              Meals				x                 x		$1,540.00 $536.00

				Program Analyst		 Dubai Municipality		11/3/22		                    		10/30/2022-11/4/2022								Registration Fee				x		$410.00

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Barakat Mahmoud		16th Dubai International Food Safety Conference		11/1/22				Dubai World Trade Center		Dubai Municipality						Common Carrier Taxi/Shuttle				xx		$1,200.00  $50.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging              Meals				xx		$1,540.00 $536.00

				Senior Science Advisor		 Dubai Municipality		11/3/22		                    		10/30/2022-11/4/2022								Registration Fee				xx		$410.00

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				John Jarosh		International Assoc. for Food Protection Program Committee Meeting		2/17/23				Toronto, CA		International Association for Food Protection (IAFP)						Lodging				x		$659.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$194.00

				Deputy Director		IAFP		2/18/23		                    		2/16/2023-2/19/2023

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Julian Jon T. Reyes		Departments of Biological & Agricultural Engineering & Water Management & Hydrologic Sciences Seminar		10/12/22				College Station, TX		Texas A&M University						Common Carrier				x		$300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		$192.00

				National Climate Hubs Coordinator		Texas A&M University		10/12/22		                    		10/11/2022-10/13/2022								Meals				x		$120.00

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		84		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		85		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		86		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		87		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		88		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		96		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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																																Internal OGE Use Only



																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Agency		FHFA

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for , FNS for the reporting period [MARK REPORTING PERIOD]

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

																REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				FNS

				Agency Contact:		Andrew Tobin		andrew.tobin@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Julie Brewer		Central Coast Organic School Food Summit		1/23/23				California		Paicines Ranch						Lodging				x		$98.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$59.00

				Director		Conscious Kitchen		1/24/23		                    		1/23/2023-1/25/2023

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              



				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

										                    										                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		97		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Board		FHFB

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov









RENAME BLANK FORM



																				OGE Form-1353
(OGE-Approved Alternative for SF-326)
February 2011





		1353 Travel Report for U.S. Department of Agriculture, Agricultural Research Service - Midwest Area for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				U.S. Department of Agriculture										X		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				Agricultural Research Service - Midwest Area

				Agency Contact:		Karen Hughes		Karen.Hughes@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Martin Williams		Writing Workshop for Proposal		10/5/22				Fayetteville, AR		Virginia Tech						Hotel				X		$384.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$518.00

				Res Ecologist		Virginia Tech		10/7/22		                    		10/4/2022-10/8/2022								Meals/Ground Transportation		X		X		$227

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tavis Anderson		American Assoc of Veterinary Laboratory Diagnosticians Meeting		10/6/22				Minneapolis, MN		American Assoc of Veterinary Laboratory Diagnosticians						Registration				X		$300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				X		$380

				Res Biologist		American Assoc of Veterinary Laboratory Diagnosticians		10/12/22		                    		10/7/2022-10/10/2022								Mileage		X				$99

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Heping Zhu		New Frontiers: Targeted Solutions for Sustainable Agriculture		10/11/22				Indianapolis, IN		Corteva Agriscience						Hotel				X		$254

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$138

				Res Agricultural Engineer		Corteva Agriscience		10/13/22		                    		10/11/2022-10/13/2022								Mileage/Parking				X		$380

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jay S Johnson		Kemin Intestinal Health Symposium		10/12/22				Indian Wells, CA		Kemin Industries						Hotel				X		$1,068

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$611

				Res Animal Scientist		Kemin Industries		10/14/22		                    		10/11/2022-10/15/2022								Meals/Ground Transportation/Parking				X		$673

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Carl Bernacchi		Soil and Crop Sciences Seminar		10/13/22				Ithaca, NY		Cornell University						Hotel				X		$268

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$535

				Res Plant Physiologist		Cornell University		10/13/22		                    		10/12/2022-10/14/2022								Meals/Ground Transportation		X		X		$205

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Douglas Allen		Washington State University, Institute of Biological Chemistry's Seminar Series		10/20/22				Pullman, WA		Washington State University						Hotel				X		$392

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$400

				Res Computatioal Biologist		Washington State University		10/20/22		                    		10/19/2022-10/23/2022								Meals				X		$214

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brian Kerr		NutriQuest Technical Exchange Speakership		10/23/22				Syracuse, NE		NutriQuest						Hotel				X		$200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$82

				Res Animal Scientist		NutriQuest		10/25/22		                    		10/23/2022-10/25/2022								                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Vincent Baker		University of Pennsylvania, Center of Excellence for Influenza Research and Response Scientific Advisory Board Meeting		10/24/22				Philadelphia, PA		University of Pennsylvania						Hotel		X				$198

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$450

				Res Vetnry Medcl Offcr		University of Pennsylvania 		10/25/22		                    		10/24/2022-10/25/222								Meals		X				$140

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tavis Anderson		University of Pennsylvania, Center of Excellence for Influenza Research and Response Scientific Advisory Board Meeting		10/24/22				Philadelphia, PA		University of Pennsylvania						Hotel		X				$198

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$450

				Res Biologist		University of Pennsylvania		10/25/22		                    		10/24/2022-10/25/2022								Meals		X				$140

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Yiqun Weng		USDA-SCRI-CucCAP2 Project Meeting; Cucurbitaceae 2022 International Meeting		10/30/22				Naples, FL		Michigan State University						Hotel				X		$310

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$650

				Res Geneticist		Cucurbitaceae 2022 Local Organizing Committee		11/3/22		                    		10/29/2022-11/5/2022								                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Milton Drott		Invasion and Evolution		10/30/22				Pretoria, South Africa		University of Mississippi						Hotel				X		$1,300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$1,500

				Res Plant Pathologist		Forestry and Agricultural Biotechnology Institute		11/19/22		                    										Meals/Ground Transportation/Parking		X		X		$1,010

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Owen		Apex 2022 Horticulture Short Course		11/1/22				Lathrop, CA		J.R. Simplot Company						Hotel				X		$700

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$545

				Res Horticulturist		J.R. Simplot Company		11/3/22		                    		10/31/2022-11/4/2022								Meals/Rental Car/Gas/Parking		X		X		$608

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kristen Veum		ASA-CSSA-SSSA Annual Meeting		11/5/22				Baltimore, MD		American Society of Agronomy						Hotel				X		$644

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$832

				Res Soil Scientist		American Society of Agronomy		11/9/22		                    		11/4/2022-11/9/2022								Meals/Ground Transportation/Parking/Mileage/Registration		X		X		$1,010

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Douglas Allen		Realizing Increased Photosynthetic Efficiency Meeting		11/8/22				Urbana, IL		University of Illinois						Hotel				X		$294

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$206

				Res Computational Biologist		University of Illinois		11/11/22		                    		11/8/2022-11/11/2022								                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mark Ackermann		American College of Veterinary Pathologists		11/10/22				Boston, MA		American College of Veterinary Pathologists						Hotel				X		$1,500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$900

				Center Director		American College of Veterinary Pathologists		11/16/22		                    		11/9/2022-11/15/2022								Meals/Ground Transportation/Mileage/Parking		X		X		$470

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Anna Testen		Penn State Department of Plant Pathlogy and Environmental Microbiology Seminar		11/13/22				State College, PA		Pennsylvania State University						Hotel				X		$320

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$173

				Res Plant Pathologist		Pennsylvania State University		11/15/22		                    		11/13/2022-11/15/2022								Ground Transportation		X				300

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Martin Williams		Speaking Engagement and Site Visit		11/29/22				Kuala Lumpur, Malaysia		Green World Genetics						Hotel				X		$744

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Res Ecologist		Green World Genetics		12/1/22		                    		11/26/2022-12/2/2022								                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Baker		2022 North American PRRS/NC229 International Conference of Swine Viral Diseases		12/2/22				Chicago, IL		2022 NAPRRS/NC229 ICSVD						Hotel		X				$338

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$500

				Res Vetnry Medcl Offcr		2022 NAPRRS/NC229 ICSVD Organizing Committee		12/4/22		                    		12/2/2022-12/4/2022								Registration/Ground Transportation		X				$250

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jennifer Wilson		Corn, Soybean & Sorghum Seed Expo		12/5/22				Chicago, IL		American Seed Trade Association						Hotel				X		$268

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$799

				Res Molecular Biologist		American Seed Trade Association		12/8/22		                    		12/6/2022-12/8/2022								                           

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Erik Ohlson		Corn, Soybean & Sorghum Seed Expo		12/5/22				Chicago, IL		American Seed Trade Association						Hotel				X		$268

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$799

				Res Geneticist		American Seed Trade Association		12/8/22		                    		12/6/2022-12/8/2022								                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Anna Testen		Great Lakes EXPO		12/6/22				Grand Rapids, MI		Great Lakes EXPO						Hotel				X		$248

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$161

				Res Plant Pathologist		Great Lakes EXPO		12/8/22		                    		12/5/2022-12/7/2022								Ground Transportation/Tolls		X		X		$225

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Osterholz		Wisconsin Discovery Farms Conference		12/14/22				Wisconsin Dells, WI		University of Wisconsin						Hotel		X				$250

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$300

				Res Soil Scientist		University of Wisconsin		12/14/22		                    		12/13/2022-12/15/2022								Meals/Rental Car/Gas/Parking		X				$400

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				 Jarlath Nally		Veterinary Continuing Education on Animal Leptospirosis		1/4/23				Lexington, KY		University of Kentucky						Hotel		X				$400

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$800

				Res Microbiologist		University of Kentucky		1/6/23		                    		1/3/2023-1/7/2023								Meals		X				$150

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Rex Nelson		Animal Plant and Animal Genome Conference		1/13/23				San Diego, CA		Scherago International						Hotel				X		$483

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$845

				Comp Biologist		Scherago International		1/18/23		                    		1/12/2023-1/18/2023								                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Subhashree Subramanyam		Plant and Animal Genome Conference		1/13/23				San Diego, CA		Scherago International						Hotel				X		$705

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$250

				Res Molecular Biologist		Scherago International		1/18/23		                    		1/13/2023-1/16/2023								Registration				X		$845

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Philipp Simon		Plant and Animal Genome Conference		1/13/23				San Diego, CA		Scherago International						Hotel				X		$511

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$845

				Res Geneticist		Scherago International		1/18/23		                    		1/12/2023-1/19/2023								Misc Expenses				X		$250

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Stephen Goodwin		Plant and Animal Genomes		1/13/23				San Diego, CA		Scherago International						Hotel				X		$618

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$250

				Res Plant Pathologist		Scherago International		1/18/23		                    		1/13/2023-1/1/2023								Registration				X		$895

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Charles Crane		Plant and Animal Genome		1/13/23				San Diego, CA		Scherago International						Hotel				X		$620

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$306

				Res Geneticist		Scherago International		1/18/23		                    		1/15/2023-1/1/2023								Registration/Meals				X		$890

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Shaun Curtin		Plant and Animal Genome		1/13/23				San Diego, CA		Scherago International						Hotel				X		$322

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$478

				Res Geneticist		Scherago International		1/18/23		                    		1/12/2023-1/14/2023								Registration				X		$895

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jamie O'Rourke		Plant and Animal Genome		1/13/23				San Diego, CA		Scherago International						Hotel				X		$483

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$250

				Res Geneticist		Scherago International		1/18/23		                    		1/15/2023-1/18/2023								Registration				X		$895

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Karen Cichy		Research Oversight Committee Meeting for EVOLVES Project		1/14/23				San Diego, CA		Genome Prairie						Hotel				X		$322

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$747

				Res Geneticist		Genome Prairie		1/14/23		                    		1/13/2023-1/15/2023								Meals				X		$113.75

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary Beth Hall		Pacific Northwest Animal Nutrition Conference		1/16/23				Boise, ID		Pacific Northwest Nutrition Conference						Hotel				X		$370

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$500

				Res Animal Scientist		Pacific Northwest Animal Nutrition Conference		1/17/23		                    		1/16/2023-1/18/2023								Meals/Ground Transportation/Parking				X		$258

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dennis Hancock		Tour de Forage		1/24/23				Rochester, MN		Midwest Forage Association						Hotel				X		$387

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Center Director		Midwest Forage Association		1/26/23		                    		1/23/2023-1/26/2023								                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chad Penn		2023 Drainage Conference		1/25/23				London, OH, Canada		Land Improvement Contractors of Ontario						Hotel				X		$270

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$235

				Res Soil Scientist		Land Improvement Contractors of Ontario		1/26/23		                    		1/24/2023-1/26/2023								                           

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Anna Testen		Mid-Atlantic Fruit and Vegetable Convention		1/30/23				Hershey, PA		Pennsylvania Vegetable Growers Association						Hotel		X				$175

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		X				$55

				Res Plant Pathologist		Pennsylvania Vegetable Growers Association		2/2/23		                    		1/31/2023-2/1/2023								Registration		X				$500

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeffrey Neyhart		Corteva Plant Science Symposium		2/7/23				Manhattan, KS		Kansas State University						Hotel				X		$200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$350

				Res Geneticist		Kansas State University		2/7/23		                    		2/6/2023-2/8/2023								Meals/Ground Transportation/Baggage		X				$310

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sharon Weyers		Sustainable Agriculture Research and Education Administrative Council Meeting		2/8/23				St Charles, MO		University of Minnesota						Hotel				X		$294

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$410

				Res Soil Scientist		Sustainable Agriculture Research and Education		2/9/23		                    		2/7/2023-2/10/2023								Meals/Mileage/Parking		X		X		$549

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jay S Johnson		DSM Swine Days		2/15/23				Madrid, Spain		DSM Nutritional Products						Hotel				X		$800

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$800

				Res Animal Scientist		DSM Nutritional Products		2/17/23		                    		2/13/2023-2/18/2023								Meals/Ground Transportation				X		$250

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Baker		WHO Consultation on the Composition of Influenza Virus Vaccines for the Northern Hemisphere		2/20/23				Geneva, Switzerland		World Health Organization						Hotel		X				$1,000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$1,800

				Res Vetnry Medcl Offcr		Word Health Organization		2/24/23		                    		2/18/2023-2/25/2023								Meals/Ground Transportation				X		$1,478

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Shawn Bearson		National Turkey Federation Convention		2/22/23				Palm Springs, CA		National Turkey Federation						Registration				X		$1,800

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Res Microbiologist		National Turkey Federation		2/25/23		                    		2/22/2023-2/26/2023								                           

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kristen Veum		Congressional Visits Day		2/27/23				Washington, DC		American Society of Agronomy						Hotel				X		$426																		American Society of Agronomy

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$600

				Res Soil Scientist		American Society of Agronomy		2/28/23		                    		2/26/2023-2/28/2023								Meals/Ground Transportation		X		X		$305

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christopher Anderson		American Society of Animal Science		3/12/23				Madison, WI		American Society of Agronomy						Hotel		X				$550																		American Society of Agronomy

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$675

				Res Microbiologist		American Society of Animal Science		3/15/23		                    		3/12/2023-3/15/2023								Meals/Mileage		X				$692

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Elmore		Rutgers Turfgrass Symposium		3/16/23				New Brunswick, NJ		Rutgers University						Hotel				X		$250																		Rutgers University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$600

				Res Plant Molecular Geneticist		Rutgers University		3/16/23		                    		3/15/2023-3/17/2023								Meals/Ground Transportation		X				$200

		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Justin Greenlee		North American Deer Farmer's Association Conference		3/22/23				French Lick, IN		North American Deer Farmer's Association						Meals				X		$30																		North American Deer Farmer's Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$350

				Res Vetnry Medcl Offcr		North American Deer Farmer's Association		3/25/23		                    		3/22/2023-3/25/2023								                           

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Eric Cassman		North American Deer Farmer's Association Conference		3/22/23				French Lick, IN		North American Deer Farmer's Association						Meals				X		$30																		North American Deer Farmer's Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		$350

				Res Vetnry Medcl Offcr		North American Deer Farmer's Association		3/25/23		                    		3/22/2023-3/25/2023								                           

		46		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Matthew Moscou		Molecular Plant Sciences Graduate Program Seminar Series		3/27/23				Pullman, WA		Washington State University						Hotel				X		$291																		Washington State University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$792

				Res Plant Pathologist		Washington State University		3/30/23		                    		3/27/2023-3/30/2023								Meals/Ground Transportation		X		X		$357

		47		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brian Kerr		Mid-Atlantic Nutrition Conference		3/28/23				Gettysburg, PA		Evonik Animal Nutrition						Hotel				X		$200																		Evonik Animal Nutrition

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$400

				Res Animal Scientist		University of Maryland		3/29/23		                    		3/27/2023-3/29/2023								                           

		48		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Amy Baker		Immunology and Microbiology Departmental Seminar		3/31/23				Aurora, CO		University of Colorado						Hotel				X		$150																		University of Colorado

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$300

				Res Vetnry Medcl Offcr		University of Colorado		3/31/23		                    		3/30/2023-3/31/2023								                           

		49		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		50		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		51		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		52		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		53		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		54		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		55		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		56		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		57		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		58		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		59		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		60		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		61		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		62		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		63		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		64		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		65		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		66		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		67		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		68		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		69		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		70		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		71		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		72		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		73		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		74		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		75		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		76		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		77		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		78		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		79		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		80		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		81		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		82		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		83		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		84		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		85		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		86		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		87		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		88		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		90		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		91		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		93		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		94		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		95		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		96		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		97		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           





																																Internal OGE Use Only



																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Board		FHFB

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for U.S. Department of Agriculture, Agricultural Research Service for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				U.S. Department of Agriculture										X		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				Agricultural Research Service

				Agency Contact:		Karen Bratcher		karen.bratcher@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alanna Moshfegh		22nd International Congress of Nutrition		12/6/22				Tokyo, Japan		International Congress of Nutrition 						Hotel 				x		$1,052

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		$2,669.00

				Research Leader		Hisanori Kato, Ph.D., Chair 22nd International Congress of Nutrition Organizing Committee		12/11/22		                    		12/4/2022-12/11/2022								Registration 				x		$588

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Carrie Laboski		American Society of Agronomy - Crop Science Society of America - Soil Science of America Annual Meeting		11/5/22				Baltimore, Maryland		Soil Science of America						Hotel 				x		$800

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per diem (meals) 				x		$310

				Research Leader		Soil Science of America		11/9/22		                    		11/4/2022-11/9/2022

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Erin Galarneau				11/8/22				Oak Spring Garden Foundation, Upperville, VA		Oak Spring Garden Foundation						Hotel 				x		$392

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										meals 				x		$121

				Molecular Biologist		Conservation of North American Native Grapes Workshop		11/10/22		                    		11/7/2022-11/11/2022

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Hepler		Entomological Society of America, Entomological Society of Canada, and Entomological Society of British Columbia Joint Meeting		11/13/22				Vancouver, Canada		Entomological Society of America 						Hotel 				x		$776

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		$1,300

				Research Entomologist		Entomological Society of America		11/16/22		                    		11/12/2022-11/17/2022								meals 330 and registration 695				x		1025

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christine Moore		Monthly meeting of the North Carolina Unit of the Herb Society of America		11/17/22				Greensboro, NC		North Carolina Unit of the Herb Society of America						hotel 				x		$150

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										meals 				x		$50

				Horticulturist		North Carolina Unit, Herb Society of America		11/17/22		                    		11/16/2022-11/17/2022								trans fee 		x				$15

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Taina Litwak		Corteva Plant Science Symposium 2022 		11/18/22				West Lafayette, IN 		Department of Botany and Plant Pathology, Purdue Univeristy						Hotel		x		 		$0.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		 		x		$0.00

				Scienctific Illustrator		Purdue University		11/18/22		                    		11/17/2022-11/19/2022								Taxi $60/Meals $100		x 		 		$0.00

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Courtney Hammond Wagner		Natural Resources & Environmental Sciences Seminars		11/3/22				University of Illinois Urbana-Champaign		Department of Natural Rescources & Environmental Sciences						Air Transportation		 		x		$1,021

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		 		x		$67

				Research Social Scientist		University of Illinois Urbana-Champaign		11/4/22		                    		11/2/2022-11/5/2022								Hotel		 		x		$288

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brendan A. Niemira 		11th Annual American Food Sure Summit		3/30/23				Chicago, IL		MA Exhibitions, Mark Allen Group						Hotel		 		x		$200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration 		 		x		$510.00

				Research Plant Pathologist		MA Exhibitions, Mark Allen Group, St. Jude's Church, Dulwich Road, London, SE24 0PB, United Kingdom		3/31/23		                    		03/29/2023-04/01/2023

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Emily Pfeufer		Distinguished Seminar Speaker		11/9/22				Meadville PA 		Allegheny College Department of Biology						Hotel		 		x		$130

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		 		x		$32.00

				Research Plant Pathologist		Catharina Coenen,		11/10/22		                    		11/9/2022-11/10/2022

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Doreen H. Ware		Institute of Bioinformatics Faculty Seminar		11/18/22				Athens, GA		University of Georgia						Air Transportation		 		x		$500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi $179.00/Taxi $150.00		 		x		$329

				Research Molecular Biologist		University of Georgia		11/18/22		                    		11/17/2022-11/20/2022								Meals		 		x		$100

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Richard T. Olsen		Phoebe Cook Lecture		11/17/22				Memphis, TN		Dixon Gallery and Gardens						Meals		 		x		$180.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel		 		x		$360

				Center Director		Memphis Garden Club		11/17/22		                    		11/15/2022-11/18/2022								Air Transportation $544/Taxi $60/Parking $48		x		 		$652

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Carrie Laboski		Mid-Atlantic Crop Management School 		11/15/22				Ocean City, Maryland		Mid-Atlantic Crop Management School						Hotel		 		x		$150

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		 		x		$100

				Research Leader		Cooperative Extension		11/16/22		                    		11/15/2022-11/16/2022

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kathryn Bushley 		The 2022 National Soybean Nematode Conference		12/14/22				Savannah, GA		American Phytopathological Society						Air Transportation		x		 		$320

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration 		 		x		$299

				Molecular Biologist		American Phytopathological Society		12/16/22		                    		12/14/2022-12/17/2022

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gennaro Fazio		Visit to G.213 apple rootstock field trials and VII Field day on rootstocks from CG (Geneva) series in Brazil		1/15/23				Caxias do Sul-RS, Vacaria, RS, and Lages, SC.		Agromillora Producao E Comercio De Mudas Vegetais Ltda						Air Transportation		x		 		$3,000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel		 		x		$500

				Research Geneticist		Agromillora Producao E Comercio De Mudas Vegetais Ltda		1/20/23		                    		1/14/2023-1/20/2023								Meals		 		x		$200

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Barbara Shukitt-Hale		Nutrition Research Meeting of the California Strawberry Commission (the 2022 CSC Health Research Conference)		12/8/22				Westlake Village, CA		California Strawberry Commission						Hotel				x		$300.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		$250

				Research Psychologist		Chris Christian		12/8/22		                    		12/7/2022-12/9/2022								Meals				x		$85

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Li Li 		Biology and Applications of Carotenoids, Retinoids and Other Apocarotenoids (Carotenoids - Gordon Research Conference)		1/8/23				Ventura, CA		Gordon Research Conference						Registration 		x				$1,595

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Research Molecular Biologist		Gordon Research Conference		1/13/23		                    		11/7/2023-11/14/2023

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manan Sharma		2023 International Association for Food Protection Program Committee Meeting		2/17/23				Ontario, Canada		International Association for Food Protection (IAFP)						Hotel				x		$675

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		$500

				Research Microbiologist		International Association for Food Protection		2/18/23		                    		2/16/2023-2/19/2023								Parking $80/Meals $225				x		$305

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jay D Evans		American Beekeeping Federation (ABF) Annual Conference & Trade Show		1/3/23				Jacksonville, FL		American Beekeeping Federation						Hotel				x		$450

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$160

				Research Entomologist		American Beekeeping Federation		1/7/23		                    		1/3/2023-1/8/2023

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				BEN GUTIERREZ		GLOBAL STRATEGY FOR THE CONSERVATION AND USE OF  FRUIT  TREE  GENETIC  RESOURCES 		1/30/23				Benevento, Italy		DiCoVaLe Project						Air Transportation				x		$1,000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				x		$1,500

				GENETICIST/CURATOR		DiCoVaLe Project		1/31/23		                    		1/27/2023-2/1/2023								Taxi				x		$200

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tracy Leskey		Specialty Crop Research Initiative		12/12/22				Chicago, Illinois		Univeristy of Wisconsin-Madison						Air Transportation				x		$374

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				x		$268

				Research Entomologist		Univeristy of Wisconsin-Madison		12/13/22		                    		12/11/2022-12/13/2022								Meals $76/Taxi $100				x		$176

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David H Kingsley 		Fisheries conference		2/26/23				Renton Washington		Fisheries Conference						Registration 				x		$400

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Scientist		Fisheries Conference		3/1/23		                    		2/25/2023-3/2/2023

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Courtney Hammond Wagner		Book Workshop& Meeting		12/15/22				Hanover, New Hampshire 		Dartmouth College						Hotel				x		$400

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$26

				Research Social Scientist		Dickey Center for International Understanding, Dartmouth College  Hanover, New Hampshire 		12/16/22		                    		12/15/2022-12/17/2022

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ronald Ochoa		Research on Brevipalpus californicus meeting		1/29/23				Homestead, FL		University of Florida						Hotel				x		$1,500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Research Entomologist		University of Florida		2/26/23				1/28/2023-2/27/2023

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Barbara Shukitt-Hale		9th Biennial Berry Health Benefits Symposium (BHBS)		1/31/23				Tampa, FL		The National Berry Crops Initiative						Hotel				x		$600.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		$300

				Research Psychologist		Darcy Kochis		2/2/23				1/30/2023-2/3/2023								Meals $100/Registration $600				x		700

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James J. Giovannoni		Gene editing for improved fruit quality and nutrition		1/28/23				Inter American University of Puerto Rico - Bayamon Campus		Inter American University of Puerto Rico						hotel				x		$477

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										air				x		$870

				Molecular Biologist		Inter American University of Puerto Rico		1/30/23				1/28/2023-1/31/2023								meals 240/taxi 125				x		$365

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Moon S. Kim		Cooperative project progress meetings - seminar on sensing and instrumentation technology development for food safety		3/7/23				Kangwon National University		Gangwon National University						air				x		4500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										taxi/shuttle 				x		100

				Research Leader		Gangwon National University		3/14/23		                    		3/5/2023-3/15/2023								                           

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Taina Litwak		The theme of this year’s symposium is “Plant Science Careers: Thinking Outside the Box”.  I have been invited to give a talk about my career as scientific illustrator.  No personal/annual leave taken.		11/18/22				West Lafayette, IN 47907		 Purdue University						hotel / hotel tax 34.56		x				322.56

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										air 		x				438

				Scienctific Illustrator		 Dept. of Botany and Plant Pathology, Purdue University		11/18/22		                    		11/17/2022-11/19/2022								taxi / meals 80		x				210

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jacob Shreckhise		InvigorateU 2023 Conference		1/18/23				Bloomington, IL		South Jersey Unit, Herb Society of America						hotel 				x		115

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										air / pov $103		x				741.4

				Reserach Horticulturist		Illinois Green Industry Association		1/18/23		                    		1/17/2023-1/18/2023								Per diem (meals) 		x				88.5

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christine Moore		South Jersey Unit, Herb Society of America monthly meeting		1/15/23				Franklinville, NJ (Morris County)		South Jersey Unit, Herb Society of America						hotel 				x		161

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										meals 				x		69

				Horticulturist		South Jersey Unit, Herb Society of America		1/15/23		                    		1/14/2023-1/15/2023								tolls and concur fee		x				114.5

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Zhong, Gan-Yuan 		Plant & Animal Genome 30 Conference 		1/13/23				Town & Country Resort and Conference Center		Scherago International						hotel 				x		1000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration 				x		895

				Supvy Res Genet		Scherago International		1/18/23		                    		1/12/2023-1/18/2023								                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sarah C Goslee		Northeast SARE Winter Meeting		2/21/23				Burlington, VT		Northeast SARE						hotel 				x		300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										air 				x		550

				Ecologist		Northeast SARE		2/23/23		                    		2/21/2023-2/23/2023								meals and taxi 50				x		250

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Monika Proszkowiec-Weglarz		Arm & Hammer Animal and Food Production		2/9/23				Waukesha, WI		Church & Swight Co. Inc						Air transportation				x		197.95

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				x		157.07

				Research Molecular Biologist		Church & Swight Co. Inc		2/9/23		                    		2/8/2023-2/9/2023								                           

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Paulo Reis Vieira		Improve molecular and methodologies		3/16/23				Brazil		Brazilian Federal Agency for Support and Evaluation of Gradueate Education						Hotel				x		2595.91

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Travel allowance				x		936.38

				Research Molecular Biologist		Prof. Thais Ribeiro Santiago and Prof. Danilo Batista Pinho 		3/15/23		                    		3/15/2023-3/31/2023								Health Ins $74.17/Settling $407.93				x		482.1

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Paulo Reis Vieira		Beech leaf disease: 		1/31/23				Penn State University, PA		Department of Plant Pathology and Environmental Microbiology						Hotel				x		154.29

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		150146.93

				Research Molecular Biologist		Dr. Mihail Kantor		2/2/23		                    		1/30/2023-2/3/2023								Mileage $132.93/Parking $12				x

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Benjamin Rosen		Department of Animal Science seminar		3/15/23				 East Lansing, MI		Michigan State University Department of Animal Science						Hotel				x		250

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		100

				Research Biologist 		Michigan State University		3/15/23		                    		3/14/2023-3/16/2023								Air Transp $325/Taxi $150				x		475

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brendan A. Niemira		IFT Leadership Development Committee		2/27/23				Chicago, Illinois		Governance and Leadership Development Institute of Food Technologiest						Hotel				x		400

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				x		200

				Plant Pathologist		Institute of Food Technologiest		3/1/23		                    		2/27/2023-3/1/2023								Taxi $50 /Meals $100				x		150

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Asha Miles		National Dairy Herd Information Association Business Meeting		3/6/23				Sacramento CA		National Dairy Herd Information Association						Registration 				x		650

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				x		685

				Research Geneticist		National Dairy Herd Information Association		3/9/23		                    		3/5/2023-3/9/2023								Meals				x		385

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Doreen H. Ware		ELIXIR Scientific Advisory Board Meeting		2/14/23				Cambridge, UK		ELIXIR Scientific Advisory Board						Air Transportation		x				1300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi				x		200

				Research Molecular Biologist		ELIXIR Scientific Advisory Board		2/16/23		                    		2/13/2023-2/17/2023								Hotel $996/In County Transfer$200				x		1196

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Yniv Palti		Annual meeting of the US and Israeli BARD TAC (		3/27/23				Israel		BARD US-Israel Binational Agricultural Research and Developmment						Per diem(meals)$1254/Taxi $$300		x				1554

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				x		740

				Research Geneticist		BARD US-Israel		3/29/23		                    		3/25/2023-3/31/2023								Air Trans $1353.77/Parking $140/Process Fee $28/Mileage $65.50						1587.27

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gregory W. McCarty		US-Taiwan Conference on Carbon Neutral Agriculture		3/5/23				Taipei Taiwan		Taiwan Council of Agriculture						air 				x		7233

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										hotel 				x		830

				Research Soil Scientist		Taiwan Council of Agriculture		3/10/23		                    		3/3/23-3/11/23								taxi 330/meals 370				x		700

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Benjamin Rosen		The Advances in Genome Biology and Technology (AGBT) Agriculture meeting		3/27/23				Hyatt Hill Country, San Antonio, Texas		The Genome Partnership						air 				x		500																		The Genome Partnership

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										hotel 				x		496

				Research Biologist (Computational)		The Genome Partnership		3/29/23		                    		3/26/23-3/29/23								registration, taxi, meals 				x		1481

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michelle L. Heck 		Center for Microbiome - International Microbiome Meeting		3/14/23				San Diego, CA		University of California, San Diego 						air 				x		997																		University of California, San Diego 

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										hotel 				x		724

				Research Molecular Biologist 		University of California, San Diego 		3/16/23		                    		3/13/23-3/17/23								meals, parking, cab				x		372

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michelle L. Heck 		Bio Solutions Conference & Expo		2/23/23				Reno, NV 		Meister Media 						hotel 				x		240																		Meister Media 

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										registration 				x		345

				Research Molecular Biologist 		Meister Media 		2/24/23		                    		2/21/23-2/24/23								                           

		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ransom Baldwin		National DHIA Leadership Session and 58th National DHIA Annual Business Meeting		3/7/23				Sacramento, CA		National Dairy Herd Improvement Association						registration 				x		650																		National Dairy Herd Improvement Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										hotel 				x		685

				Research Leader AGIL		National Dairy Herd Improvement Association		3/8/23		                    		3/6/23-3/9/23								meals 				x		350

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Edward S. Buckler, IV		Advances in Genome Biology and Technology (AGBT) Meeting - AGBT AG 2023		3/26/23				San Antonio, Texas 		International Maize and Wheat Improvement Center (CIMMYT) 						registration includes hotel, meals and taxi 				x		1650																		International Maize and Wheat Improvement Center (CIMMYT) 

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Geneticist		International Maize and Wheat Improvement Center (CIMMYT) 		3/29/23		                    		3/25/23-3/31/23								                           

		46		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Reis Vieira, Paulo C.		Improve molecular and methodologies for the identification and prediction of new nematode outbreaks		3/16/23				University of Brasilia		Brazilian Federal Agency for Support and Evaluation of Graduate Education (CAPES)						hotel and meals 				x		0																		Brazilian Federal Agency for Support and Evaluation of Graduate Education (CAPES)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										air 				x		0

				Research Molecular Biologist		Brazilian Federal Agency for Support and Evaluation of Graduate Education (CAPES)		3/31/23		                    		3/15/23-3/31/23								Health Ins $74.17/Settling $407.93				x		0
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Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Board		FHFB

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov
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		1353 Travel Report for USDA - Agricultural Research Service, PLAINS AREA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				USDA - Agricultural Research Service										x		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				PLAINS AREA

				Agency Contact:		Paula DiSabella		paula.disabella@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Robert Cushman		Seminar Presentation		10/20/22				Blacksburg, VA		Virginia Technical University						Air Transportation		X				$750

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				X		$246

				Research Physiologist		Virginia Technical University		10/21/22		                    		10/19/2022 - 10/21/2022								                           

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Tara McDaneld		Communications Workshop for Graduate Students		10/6/22				Sioux Falls, SD		South Dakota State University						Lodging				X		$96

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$88.50

				Research Geneticist		South Dakota State University		10/7/22		                    		10/05/2022 - 10/06/2022								                           

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Christopher Richards		Committee meeting		10/25/22				Germany		The Global Crop Diversity Trust						Airfare				X		1600

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		500

				Geneticist		The Global Crop Diversity Trust		10/26/22		                    		10/22/2022 - 10/26/2022								Per Diem/Ground Transportation				X		402

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jeff Herrick		Panel Member		10/17/22				France		UNEP IRP						Airfare				X		1500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem		X				550

				Research Soil Scientist		UNEP IRP		10/20/22		                    		10/16/2022 - 10/20/2022								Lodging		X				1089

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Matthew Crouse		Present Research at University		10/14/22				Fargo, ND		North Dakota State University						Lodging				X		196

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Mileage		X				620

				Research Physiologist		North Dakota State University		10/14/22		                    		10/13/2022 - 10/15/2022								Per Diem		X				147.5

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kathleen Yeater		Lead and attend a session of the ASA		11/6/22				Baltimore, MD		ACSESS (Alliance of Crop, Soil, and Environmental Science Societies)						Lodging / Common Carrier / Mileage / Taxi		X				822.5

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration				X		575

				Area Statistician		ACSESS		11/10/22		                    		11/06/2022 - 11/10/2022								                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manuel Borca		Discuss and introduce concepts of transboundary animal diseases		10/17/22				Buenos Aires, Argentina		International Atomic Energy Agency						Lodging / Meals		X				2020

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Airfare				X		1287

				Microbiologist		International Atomic Energy Agency		10/21/22		                    		10/15/2022 - 10/22/2022								                           

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Rand Broadway		Traveler will speak about ARS Livestock Issues Research Unit's work on pathogen reduction, prevalence, and immunology in cattle		10/12/22				Indian Wells, CA		Kemin Industries						Lodging / Air / Meals / Registration
				X		1300.2

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi / Meals / Baggage		X				379.5

				Research Animal Scientist		Kemin Industries		10/14/22		                    		10/12/2022 - 10/14/2022								Mileage / Parking		X				65.63

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Thomas Geary		Present research of interest to university faculty, students and producers applicable to research and livestock production.		10/13/22				Bozeman, MT		Montana State University Department of Animal and Range Sciences						Lodging				X		330.16

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Scientist		Montana State University Department of Animal and Range Sciences		10/14/22		                    		10/12/2022 - 10/14/2022								                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Stacey Gunter		I will present significant information to the 2022 Overall Program Planning Committee		11/12/22				Albuquerque, NM		American Society of Animal Science						PerDiem / Lodging / Hotel Taxes / Tolls		X				448.07

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Leader / Acting Lab Director		American Society of Animal Science		11/14/22		                    		11/12/2022 - 11/14/2022								                           

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Larry Kuehn		Serve as panel member at the annual convention and board meeting		11/4/22				Salt Lake City, UT		American Angus Association						Airfare / Lodging / Meals				X		1062

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi / Shuttle / Parking / Meals in Transit		X				170

				Supervisory Research Geneticist		American Angus Association		11/7/22		                    		11/04/2022 - 11/07/2022								                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sean Gleason		Present an invited talk		10/31/22				Brisbane, Australia		The University of Queensland						Flights				X		2500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		650

				Research Plant Physiologist		The University of Queensland		11/2/22		                    		10/30/2022 - 11/03/2022								Registration				X		985

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Hoover		Ecosystem Transitions: Increased Variability and Regime Shifts working group		11/14/22				Santa Barbara, CA		National Center for Ecological Analysis and Synthesis						Airfare
Ground Transportation				X		500
150

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		2000

				Research Ecologist		National Center for Ecological Analysis and Synthesis		11/17/22		                    		11/13/2022 - 11/18/2022								Meals				x		360

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Carol Chitko-McKown		Attending the CRWAD 2023		1/20/23				Chicago,IL		Conference of Research Workers in Animal Disease Organizers						Registration				X		350

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Microbiologist		Zoetis, Tetracore		1/24/23		                    		1/19/2023 - 1/25/2023								                           

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Thomas Geary		Bair Ranch Foundation Seminar Series		11/8/22				Bozeman, MT		Montana Livestock Producers						Lodging				X		330.16

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Scientist		Montana Nutrition Conference		11/9/22		                    		11/08/2022 - 11/09/2022								                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gayle Volk		Coordinating the Global Conservation Strategy for Citrus.		11/28/22				Bonn, Germany		Global Crop Diversity Trust						Flight / Lodging				X		2091

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi / Meals				X		605

				Plant Physiologist		Global Crop Diversity Trust		11/29/22		                    		11/26/2022 - 11/30/2022								Train				X		100

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michael Grusak		2022 ASA-CSSA-SSSA International Annual Meeting as the Program Planning Officer 		11/6/22				Baltimore, MD		Crop Science Society of America						Lodging				X		1000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Center Director		Crop Science Society of America		11/10/22		                    		11/06/2022 - 11/10/2022								                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Rowley		Presenting current research at the Texas Society for Ecological Restoration 25th Annual Conference		11/17/22				Austin, TX		Texas A&M University, Dept. Ecology & Conservation Biology						Registration Fee				X		125

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		280

				Biological Science Technician		Texas A&M University, Dept. Ecology & Conservation Biology		11/19/22		                    		11/17/2022 - 11/19/2022								                           

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				James Bono		To present a departmental seminar		11/18/22				San Antonio, Texas		University of Texas at San Antonio 						Lodging/Flight				X		810

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Shuttle/Parking		X				85

				Research Microbiologist		Ewing Halsell Foundation of San Antonio		11/18/22		                    		11/17/2022 - 11/19/2220								Meals		X				127

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Justin Derner		Presenting on soil health and rangelands		3/8/23				Phoenix, Flagstaff, Tucson, Safford, Arizona		University of Arizona						Per Diem / Lodging				X		1,,680

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier				X		600

				Research Leader		University of Arizona		3/13/23		                    		03/07/2023 - 03/14/2023								Transportation to workshops				X		250

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Melvin Bolton		Give plenary lecture		2/11/23				Luxor, Egypt		Assiut University						Lodging				X		600

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Plant Pathologist		Assiut University		2/14/23		                    		02/10/2023 - 02/15/2023								                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Patrick Ewing		OGRAIN 2023 Winter Conference		1/27/23				Madison, WI		OGRAIN - University of Wisconsin Extension						Air Transportation
Lodging				X		400.00
208.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals
Registration				X		52.50
60.00

				Research Agronomist		OGRAIN - University of Wisconsin Extension		1/28/23		                    		01/26/2023 - 01/28/2023								Meals		X				50.75

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Julie Hess		FoodFluence Conference		1/13/23				New Orleans, LA		Soy Nutrition Institute (SNI) Global						Air Transportation				X		850

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging
Meals				X		632.00
333.00

				Research Nutritionist		The Ginger Network		1/17/23		                    		01/13/2023 - 01/17/2023								Ground Transport
Registration				X		60.00
500.00

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Shannon Osborne		Chair and presenter to NCR-SARE Admin Council		2/8/23				Saint Charles, MO		NCR-SARE (University of Minnesota)						Lodging / Meals				X		200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem / Flight / Taxi		X				707.5

				Research Agronomist		NCR-SARE		2/9/23		                    		02/08/2023 - 02/09/2023								Parking / Baggage		X				60

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Julie Hess		Meeting about the Institute of Food Technologists (IFT) Annual Event		2/15/23				Chicago, IL		Institute of Food Technologists (IFT) 						Airfare				X		558

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging/Shuttle				X		462

				Research Nutritionist		Institute of Food Technologists (IFT)		2/16/23		                    		2/14/2023 - 2/17/2023								Meals				X 		276.5

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Morrison		Giving a departmental seminar		2/16/23				College Park, PA		Penn State University						Lodging				X		300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Airfare				X		500

				Research Entomologist		Penn State University		2/18/23		                    		2/16/2023 - 2/18/2023								Meals/Shuttle				X		150

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brady Koehler		Plant & Animal Genome Conference		1/13/23				San Diego,CA		North Dakota State University						Airfare
Hotel				X		500.00
805.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		407

				Biological Science Technician		North Dakota State University		1/18/23		                    		01/12/2023 - 01/19/2023								Registration				X		475

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Daniel Nonneman		Plant & Animal Genome Conference		1/13/23				San Diego,CA		Sherago International						Airfare
Ground Transportation		X				250.00
 96.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		720

				Research Molecular Biologist		Scherago International		1/18/23		                    		01/12/2023 - 0117/2023								Registration				X		895

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Abigail Hoffarth		Plant and Animal Genome Conference and The Sugarbeet Workshop		1/14/23				San Diego, CA		Beet Sugar Development Foundation						Airfare		X				$509.20

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		X				$1,127.08

				Research Assistant		Beet Sugar Development Foundation		1/18/23		                    		01/12/2023 - 01/19/2023								Ground Transport
Meals		X				$100
$555

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chenggen Chu		Plant and Animal Genome Conference and The Sugarbeet Workshop		1/14/23				San Diego, CA		Beet Sugar Development Foundation						Airfare		X				925.2

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Shuttle / Lodging		X				1022

				Research Geneticist		Beet Sugar Development Foundation		1/18/23		                    		1/13/2023 - 1/16/2023								Per Diem		X				259

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Melvin Bolton		42nd Biennial American Society of Sugar Beet Technologists (ASSBT) Meeting		2/27/23				Savannah, GA		American Society of Sugar Beet Technologists						Lodging				X		$600.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Plant Pathologist		American Society of Sugar Beet Technologists		3/2/23		                    		02/26/2023 - 03/03/2023								                           

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Lauren Porensky		Research Seminar and Dissertation Defense		2/22/23				Greensboro, NC		University of North Carolina, Greensboro						Air Transporation				X		$500.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		$300.00

				Management Specialist		University of North Carolina, Greensboro		2/23/23		                    		02/22/2023 - 02/24/2023								Meals
Ground Transport				X		$250.00
$50.00

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Sheri Spiegal		Midwest Manure Summit		2/28/23				Green Bay, WI		University of Wisconsin-Madison Extension						Air Transportation
Meals				X		$600.00
$118.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging
Ground Transport				X		$192.00
$100.00

				Rangeland Management Specialist		University of Wisconsin-Madison Extension		2/28/23		                    		02/27/2023 - 03/01/2023								POV Mileage		X				$65.00

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Julie Hess		Food Policy Impact Conference		2/7/23				Washington, D.C.		Washington DC Section of the Institute of Food Technologists (IFT) 						Meals / Registration Fees				X		$138.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi / Lodging		X				$426.00

				Research Nutritionist		Washington DC Section of the Institute of Food Technologists (IFT) 				2/8/23		                    		2/7/2023 - 2/9/2023								Airfare		X				$774.00

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				John Eide		Biennial Meeting of the Ameican Society of Sugar Beet Technologists		2/27/23				Savannah, GA		Beet Sugar Development Foundation						Airfare		X				$859.40

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		X				$679.00

				Plant Physiologist		Beet Sugar Development Foundation		3/2/23		                    		2/26/2023 - 3/03/2023								Taxi/Per Diem		X				$429.50

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Dana Nayduch		Entomology and Nematology departmental seminar series		3/1/23				Davis, CA		University of California-Davis						Air Transportation				X		$700.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging
Ground Transport				X		$400.00
$100.00

				Research Leader		University of California-Davis		3/1/23		                    		02/28/2023 - 03/02/2023								Meals
Meals		X		X		$172.50
$172.50

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joshua Udall		Deliver Seminar		3/9/23				Edinburg, TX		University of Texas-Rio Grande Valley						Air Transportation				X		$450.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		98

				Research Leader		University of Texas-Rio Grande Valley		3/9/23		                    		03/08/2023 - 03/09/2023								Meals				X		59

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Robert Cushman		Seminar Presentation		2/20/23				Laramie, WY		University of Wyoming						Lodging				X		$294.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

				Research Physiologist		University of Wyoming		2/23/23		                    		02/20/2023 - 02/23/2023

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Thomas Geary		Montana Veterinary Medical Association 2023 Winter Meeting		1/26/23				Bozeman, MT		Montana Veterinary Medical Association						Lodging				X		$330.16

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Scientist		Montana Veterinary Medical Association		1/28/23		                    		01/26/2023 - 01/28/2023								                           

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Larry Kuehn		Board Meeting for the American Angus Association		2/21/23				Saint Joseph, Missouri		American Angus Association						Lodging				X		$196.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem				X		$147.50

				Supervisory Research Geneticist		American Angus Association		2/24/23		                    		2/21/2023 - 2/23/2023								Parking		X				$24.00

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Brandon Bestelmeyer		To develop new landscape process model		3/27/23				Phoenix, AZ		New Mexico State University						Meals		X				$138.00																		New Mexico State University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		X				410

				Research Leader		New Mexico State University		3/29/23		                    		03/27/2023 - 03/29/2023								                           

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Timothy Smith		Present research		3/27/23				San Antonio, Texas		The Genome Partnership						Lodging / Meals				X		$688.00																		The Genome Partnership

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi / Registration				X		$1,304.00

				Research Chemist		The Genome Partnership		3/29/23		                    		3/26/2023 - 3/30/2023								Airfare				X		$386.40

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Warren Chatwin		Trade show		3/5/23				Las Cruces, NM			Western Pecan Growers Association						Lodging				X		$520.00																			Western Pecan Growers Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		X				$100.00

				Research Geneticist		Western Pecan Growers Association		3/7/23		                    		03/04/2023 - 03/08/2023

		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Xinwang Wang		Trade show		3/5/23				Las Cruces, NM		Western Pecan Growers Association						Lodging				X		$520.00																		Western Pecan Growers Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		X				$100.00

				Research Geneticist		Western Pecan Growers Association		3/7/23		                    		03/04/2023 - 03/08/2023

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joseph Bosilevac		Presenting and testing		3/29/23				Romania		RIBMINS						Airfare		X				$1,631.00																		RIBMINS

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		X				$385.00

				Research Microbiologist		RIBMINS		3/30/23		                    		3/27/2023 - 3/31/2023								                           

		46		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Manuel Borca		Conference on Carbon Neutral Agriculture		3/6/23				Taiwan		Council of Agriculture						Lodging				X		$890.00																		Council of Agriculture

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Airfare				X		$7,233.00

				Microbiologist		Council of Agriculture		3/9/23		                    		3/5/2023 - 3/10/2023								Taxi/Shuttle				X		$328.00

		47		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Douglas Gladue		Conference on Carbon Neutral Agriculture		3/6/23				Taiwan		Council of Agriculture						Lodging				X		890																		Council of Agriculture

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Airfare				X		7233

				Microbiologist		Council of Agriculture		44994		                    		3/5/2023 - 3/10/2023								Taxi/Shuttle				X		328

		48		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Angelyn Hilton		Trade show		3/5/23				Las Cruces, NM		Western Pecan Growers Association						Lodging				X		$520.00																		Western Pecan Growers Association

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		X				$100.00

				Research Geneticist		Western Pecan Growers Association		3/7/23		                    		03/04/2023 - 03/08/2023

		49		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Devan McGranahan		Present research on fire and grazing management		2/23/23				Williamsburg, VA		William & Mary University						Airfare				X		$663.00																		William & Mary University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		$310.00

				Research Scientist		William & Mary University		2/24/23		                    		02/22/2023 - 02/25/2023

		50		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Susan O'Shaughnessy		BARD 2023 Technical Advisory Committee Meeting		3/27/23				Kfar Giladi, Israel		The Binational Agricultural Research and Development Fund						Air Transportation
Ground Transportation		X				$3000
$200																		The Binational Agricultural Research and Development Fund

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Hotel				X		$1,830

				Agricultural Engineer		The Binational Agricultural Research and Development Fund		3/29/23		                    		03/25/2023 - 03/30/2023								Per diem
Parking		X				$772
$60

		51		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		52		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		53		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		54		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		55		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		56		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		57		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		58		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		59		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		60		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		61		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		62		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		63		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		64		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		65		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		66		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		67		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		68		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)



		69		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

																				                           

		70		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																																												0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)

																				                           

		71		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		72		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		73		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		74		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		75		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		76		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		77		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		78		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		79		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		80		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		81		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		82		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		83		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		84		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		85		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		86		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		87		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		88		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		90		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		91		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		93		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		94		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		95		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		96		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		97		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           





																																Internal OGE Use Only



																																TRUE		OCTOBER 1, 2022- MARCH 31, 2023

																																FALSE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Board		FHFB

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov









RENAME BLANK FORM



																				OGE Form-1353
(OGE-Approved Alternative for SF-326)
February 2011





		1353 Travel Report for U.S. Department of Agriculture, ARS - PACIFIC WEST AREA for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1				2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				U.S. Department of Agriculture										X		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				ARS - PACIFIC WEST AREA

				Agency Contact:		Kimm Bridges		kimm.bridges@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ken Overturf		Western Regional Aquaculture Center IA/TC Meeting		10/12/22				Spokane , WA		Western Regional Aquaculture						Hotel				X		$409

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$818.20

				Reserch Geneticist		Western Regional Aquaculture		10/13/22		                    		10/11/22								Meals				X		$185

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Noelle Anglin		Montana Seed Potato Seminar		11/1/22				Missoula, MT		Montana State University						Air Transportation		X		$1,127.20

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		X		$172.50

				SUPVY RES GENET/RES LEADER		Montana Potato Improvement Association		11/3/22		                    		11/1/22-11/4/2022								                           

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Noelle Anglin		Washington/Oregon Potato Conference		1/24/23				Kennewick, WA		Washington/Oregon Potato Committee						Uber/Taxi		X				$73.71

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$527.20

				SUPVY RES GENET/RES LEADER		Washington/Oregon Potato Committee						1/23/2023-1/27/2023								Meals		X				$310.50

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Hart-Cooper		Meeting with Collaborators at World Ag Expo		2/15/23				Tulare, CA		Ipura Food Safety						Hotel				X		$371.80

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Chemist		Ipura Food Safety		2/16/23		                    		2/14/2023-2/16/2023								                           

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Clint Mattox		Canada Turfgrass Association Conference		2/14/23				Richmond, BC, Canada		Canada Turfgrass Association						Transportation		X				$605.91

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		X				$302.50

				Research Weed Scientist		Canada Turfgrass Association		2/16/23				2/14/2023-2/16/2023								                           

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kayla Altendorf		MBAA Eastern Tehnical Conference		3/23/23				Rehoboth Beach, DE		Master Brewers Association						Transportation		X				$886.67

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Geneticist		Master Brewers Association		3/26/23		                    		3/22 - 3/26/2023								                           

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Shaun Clare		Plant and Animal Genome Meeting		1/13/23				San Diego, CA		Rapid Genomics - LGC						Lodging				X		$1,350

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$230

				Post Doc		Plant and Animal Genome Organizing Committee		1/18/23		                    		1/12/2023-1/19/2023								Registration				X		$845Nahla

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Nahla Bassil		Tools for Polyploid		1/12/23				San Diego, CA		Texas A & M University						Lodging		X				$347.78

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$303.87

				Research Geneticist		San Diego State University		1/13/23		                    		1/11/2023-1/17/2023								Local Transportation		X				$36.48

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Claire Heintz		workshop on the conservation of North America native grapes		11/8/22				Upperville, VA		NatureServe						Lodging				X		$588

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$354

				Reserch Leader		NatureServe		11/12/22		                    		11/7/2022-11/13/2022								                           

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Karen Geldmacher		2023 Cotton Inc. Producer Tour		3/16/23				Raliegh, NC		The Cotton Board						Lodging				X		$526.62

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$868.81

				Bio Sci Tech		The Cotton Board		3/21/23		                    		3/16/2023-3/21/2023								Meals				X		$190

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Obenland		UC Fruit Ripening and Ethylene Management workshop		3/6/23				Davis, CA		University of California Postharvest Center						Lodging				X		$600

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Plant Physiologist		University of California, Davis		3/9/23		                    		3/6/2023-3/9/2023								                           

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joel Siegel		American Pistachio Growers Annual Conference		2/28/23				Carlsbad, CA		American Pistachio Growers						Lodging				X		$578

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$335

				Research Entomologist		American Pistachio Growers		3/1/23		                    		2/28/2023-3/2/2023								                           

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joel Siegel		FMC Independent Pest Advisers Meeting		3/3/23				Paso Robles, CA		FMC						Lodging				X		$578

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$240

				Research Entomologist		FMC 		3/5/23		                    		3/3/2023-3/5/2023								                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Aldaberto Rperez de Leon		Southeast Stocker Veterinary Conference		12/6/22				Starkville, MS		Merck Animal Health						Lodging				X		$402

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation				X		$1,188

				Center Director		Merck Animal Health		12/7/22		                    		12/5/2022-12/8/2022								Meals				X		$118

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Clarice Coyne		PAG Conference		1/13/23				San Diego, CA		PAG						Lodging				X		$644

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Horticulturist		Sherago Int'l		1/18/23		                    		1/12/2023-1/16/2023								                           

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Long-Xi Yu		PAG Conference		1/13/23				San Diego, CA		PAG						Lodging				X		$483

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Geneticist		Sherago Int'l		1/18/23		                    		1/12/2023-1/19/2023								                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Marilyn Warburton		CSSA 2022		11/4/22				Baltimore, MD		CSSA						Lodging				X		$959

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$1,033

				Research Leader		CSSA 2022		11/9/22		                    		11/4/2022-11/11/2022								Meals		X				$307

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Marilyn Warburton		AAAS Meeting		3/3/23				Washington, DC		AAAS						Lodging		X				$673

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$690

				Research Leader		AAAS		3/5/23		                    		02/26/23-03/6/2023								Meals & Misc		X				$610

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kimberly Garland-Campbell		ASA/CSSA/SSSA CONF		11/5/22				Baltimore, MD		ASA/CSSA/SSSA						Lodging				X

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$1,058.87

				Research Geneticist		ASA/CSSA/SSSA 		11/11/22		                    		11/4/2022-11/11/2022								Meals		X				$15.90

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Xianran Li		Plant & Animal Genome Conf		1/14/23				San Diego, CA		Plant & Animal Genome						Lodging				X		$774.78

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$140

				Research Biologist		Plant & Animal Genome 		1/19/23		                    		1/14/2023-1/29/2023								                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Devinder Sandhu		2022 annual Almond Conf		12/6/22				Sacramento, CA		The California Almond Board 						Lodging				X		$270

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$34

				Research Geneticist Plants		California Almond Board		12/7/22		                    		12/6/2022-12/7/2022								                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jacqueline Serrano		2022 Entomological Society of America, Entomological Society of Canada, Entomological Society of BC Joint Annual Meeting		11/13/22				Vancouver, British Columbia, Canada		Entomoligical Society of America						Parking ($237.24); POV Mileage ($384.75)		X				$585.99

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Entomologist		Entomological Society of America		11/16/22		                    		11/11/2022-11/17/2022								                           

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Peter Henry		Dept ofPlant Patholgy Invited Seminar		11/4/22				Pullman, WA		Washington State University						Transportation (Air and Local)				X		$780

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				X		$500

				Research Plant Pathology		Washington State University		11/14/22		                    		11/13/2022-11/15/2022								Meals				X		$50

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Peter Henry		California Strawberry Commission Research Committee Meeting		12/14/22				San Luis Obispo, CA		California Strawberry Commision						Lodging				X		$300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				X		$30

						Research Plant Pathologist		12/15/22		                    		12/14/2022-12/15/2022								                           

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Wintermantel		Southeast Regional Fruit and Vegetable Conference		1/5/23				Savannah, GA		Mississippi State University						All travel expenses (transportation [Air and Local], Lodging, and Meals)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Total Paid to the Agency		X				$1,544.36

				Research Leader		Mississippi State University		1/8/23		                    		1/4/2023-1/9/2023								                           

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Wintermantel		American Phytopathological Society Southern Division Annual Meeting in conjunction with the Emerging Viruses in Cucurbits Working Group (EVCWG) Meeting		2/13/22				Durham, NC		Mississippi State University						Air travel expenses (Transportation [Air and Local], Lodging, Meals)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Total Paid to the Agency		x				1,513.07

				Research Leader		Mississippi State University/Emerging Viruses in Cucurbits Working Group (EVCWG)		2/16/23		                    		2/13/2023-2/20/2023								                           

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				William Wintermantel		Southwest Ag Summit		2/21/23				Yuma, AZ		University of Arizona						All travel expenses (transportation [Air and Local], Lodging, and Meals)

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Total Paid to the Agency		X				$789.21

				Research Leader		Yuma Fresh Vegetable Association, Arizona Farm Bureau, University of Arizona, Arizona Western Colege		2/23/23		                    		2/22/2023-2/24/2023								                           

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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		76		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		77		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		78		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		79		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		80		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		81		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		82		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		83		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		84		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		85		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		86		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		87		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		88		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		89		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		90		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		91		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		92		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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		93		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0
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		94		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		95		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		98		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		99		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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		100		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              
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																																Internal OGE Use Only



																																FALSE		OCTOBER 1, 2022- MARCH 31, 2023

																																TRUE		APRIL 1 - SEPTEMBER 30, 2023

																																FALSE

																																1






Instruction Sheet

		Instructions for § 1353 Travel Report





		The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See 41 CFR §304-6.9).  



		Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are submitted electronically in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  



		If your agency has not accepted payments under 31 U.S.C. § 1353 for the applicable reporting period, your agency must still submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 (in PDF Format).



		Completing the OGE Form-1353



		Saving the Workbook

				Name the Workbook using your agency acronym and the reporting period using this convention:  1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

				-		Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

				-		Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th reporting cycle.

				-		Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the workbook).

		Preparing Blank Report Forms for Each Sub-Agency (if applicable)

				For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the workbook) and rename it to describe the sub-agency. 

				-		Ensure use of standardized acronyms where applicable.

				-		Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

		Completing the General Information

				Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you can tab between the fillable cells.

				Renaming the Spreadsheet Tabs

				-		Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

				-		To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each tab must have a unique name. 

				Filling in Page, Of Pages and Year

				-		Fill in the white-colored cells found below Page, Of Pages, and Year. 

				-		Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to the total number of report pages in the entire workbook.  

						-		For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total number of sheets in the workbook.

				Filling in Agency Name, Sub-Component Name, and Contact Information

				-		In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

				-		Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the spreadsheet.

				Indicating Reporting Period

				-		Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

		Filling in Travel Specific Information

				Indicating a Negative Report

				-		If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the left of negative report.

				Indicating 1353 Travel

				-		Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below "Name."

		Submitting the Report to OGE

				Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel file as an attachment to 1353Travel@oge.gov.  

		Printing Reports for Internal Agency Use and Record Keeping

		While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.



		In Excel 2007

		-		Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  

		-		With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to "Set Print Area". Select "Set Print Area". 

		-		On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

		-		To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.

		-		You can select Print from the Print Preview view or Print as you traditionally would.



		In Excel 2003

		-		Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain highlighted.


		-		Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

		-		Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be outlined with a dashed border inside of the spreadsheet.

		-		Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the file will look when it is printed.

		-		Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.















Agency Acronym

		Semiannual Report of Payment Accepted

		Agency/Sub-Agency Name		Acronym

		Administrative Conference of the United States		ACUS

		Advisory Council on Historic Preservation		ACHP

		African Development Foundation		AFDF

		Agency for International Development		AID

		American Battle Monuments Commission		ABMC

		Appalachian Regional Commission		ARC

		Appraisal Subcommittee		ASC

		Arctic Research Commission		ARTIC

		Armed Forces Retirement Home (Soldiers' & Airmen's Home)		AFRH

		Armed Services Board of Contract Appeals-- Department of Defense		ASBCA

		Barry Goldwater Scholarship Foundation		BGSF

		Broadcasting Board of Governors		BBG

		Central Intelligence Agency		CIA

		Chemical Safety & Hazard Investigation Board		CSHIB

		Christopher Columbus Fellowship Foundation		CCFF

		Comission on Civil Rights		CCR

		Commision of the Fine Arts		CFA

		Commission for Purchase from the Blind & Severely Disabled		CPBSD

		Commission for the Preservation of America's Heritage Abroad		CPAHA

		Commodity Futures Trading Commission		CFTC

		Consumer Product Safety Commission		CPSC

		Corporation for National & Community Service		CNCS

		Council of Econimic Advisors-- Executive Office of the President		CEA

		Council on Environmental Quality-- Executive Office of the President		CEQ

		Court Services & Offender Supervision Agency for DC		CSOSA

		Defense Commissary Agency-- Department of Defense		DCA

		Defense Contract Audit Agency-- Department of Defense		DCAA

		Defense Finance & Accounting Service-- Department of Defense		DFAS

		Defense Information Systems Agency-- Department of Defense		DISA

		Defense Intelligence Agency-- Department of Defense		DIA

		Defense Logistics Agency-- Department of Defense		DLA

		Defense Nuclear Facilities Safety Board		DNFSB

		Defense Security Service-- Department of Defense		DSS

		Defense Threat Reduction Agency-- Department of Defense		DTRA

		Department of Agriculture		USDA

		Department of Commerce		DOC

		Department of Defense		DOD

		Department of Education		DOED

		Department of Energy		DOE

		Department of Health & Human Services		HHS

		Department of Homeland Security		DHS

		Department of Housing & Urban Development		HUD

		Department of Justice		DOJ

		Department of Labor		DOL

		Department of State		STATE

		Department of the Air Force-- Department of Defense		DAF

		Department of the Army-- Department of Defense		ARMY

		Department of the Interior		DOI

		Department of the Navy-- Department of Defense		NAVY

		Department of Transporation		DOT

		Department of Treasury		TREASURY

		Department of Veterans Affairs		VA

		Election Assistance Commission		EAC

		Enviornmental Protection Agency		EPA

		Equal Employment Opportunity Commission		EEOC

		Executive Office of the President		EOP

		Export-Import Bank		EX-IM BANK

		Farm Credit Administration & Farm Systems Insurance Corporation		FCA

		Federal Communications Commission		FCC

		Federal Deposit Insurance Corporation		FDIC

		Federal Election Commission		FEC

		Federal Energy Regulation Commission		FERC

		Federal Housing Finance Board		FHFB

		Federal Labor Relations Authority		FLRA

		Federal Maritime Commission		FMC

		Federal Mediation & Concilitation Service		FMCS

		Federal Mine Safety & Health Review Commission		MSHRC

		Federal Reserve System		FRS

		Federal Retirement Thrift Investment Board		FRTIB

		Federal Trade Commission		FTC

		General Services Administration		GSA

		Government Accountability Office		GAO

		Harry S. Truman Scholarship The Truman Foundation		HTS

		Institute of Museum & Library Services		IMLS

		Inter-American Foundation		IAF

		International Boundary & Water Commission		IBWC

		International Joint Commission		IJC

		International Trade Commission		ITC

		James Madison Memorial Fellowship Foundation		JMM

		Japan/US Friendship Commission		JFC

		Marine Mammal Commission		MMC

		Merit System Protection Board		MSPB

		Millennium Challenge Corporation		MCC

		Morris K. Udall Foundation		MUF

		National Aeronautics & Space Administration		NASA

		National Archives & Records Administration		NARA

		National Capital Planning Commission		NCPC

		National Credit Union Administration		NCUA

		National Endowment for the Arts		NEA

		National Endowment for the Humanities		NEH

		National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense		DMA

		National Intelligence, Office of the Director		DNI

		National Labor Relations Board		NLRB

		National Mediation Board		NMB

		National Science Foundation		NSF

		National Security Agency-- Department of Defense		NSA

		National Security Council-- Executive Office of the President		NSC

		National Tranpsortation Safety Board		NTSB

		Nuclear Regulatory Commission		NRC

		Nuclear Waste Technical Review Board		NWTRB

		Occupational Safety & Health Review Commission		OSHRC

		Office of Administration-- Executive Office of the President		OA

		Office of Government Ethics		OGE

		Office of Management and Budget-- Executive Office of the President		OMB

		Office of National Drug Control Policy		ONDCP

		Office of Navajo & Hopi Indian Relocation		ONHIR

		Office of Personnel Management		OPM

		Office of Science & Technology Policy-- Executive Office of the President		OSTP

		Office of Special Counsel		OSC

		Office of the Federal Coordinator for Alaska Natural Gas Transporation Project		ANGTP

		Office of the Inspector General-- Department of Defense		OIG(DOD)

		Office of the Inspector General for Afghanistan Reconstruction		SIGAR

		Office of the Secretary-- Department of Defense		OS(DOD)

		Office of the Vice President-- Executive Office of the President		OVP

		Office of US Trade Representative-- Executive Office of the President		USTR

		Overseas Private Investment Corporation		OPIC

		Peace Corps		PEACE

		Pension Benefit Guaranty Corporation		PBGC

		Postal Rate Commission		PRC

		Railroad Retirement Board		RRB

		Recovery Accountability & Transparency Board		RAT BOARD

		Securities & Exchange Commission		SEC

		Selective Service System		SSS

		Small Business Administration		SBA

		Social Security Adminstration		SSA

		Special Inspector General for Iraq Reconstruction 		SIGIR

		Surface Transporation Board		STB

		Tennessee Valley Authority		TVA

		The President's Council on Bioethics		PCB

		The Presidio Trust		PRESIDIO

		The White House Office-- Executive Office of the President		WH

		Uniformed Services University of the Health Science-- Department of Defense		USUHS

		US Access Board		ACCESS

		US Trade & Development Agency		USTDA

		If your agency is not listed here or if you have questions about the standard acronym for your agency, please contact OGE at 1353travel@oge.gov









RENAME BLANK FORM



																				OGE Form-1353
(OGE-Approved Alternative for SF-326)
February 2011





		1353 Travel Report for U.S. Department of Agriculture, Agricultural Research Service -Southeast Area for the reporting period OCTOBER 1, 2022- MARCH 31, 2023

		No.		SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE																		PAGE		OF PAGES		YEAR

																						1		1		2023

				This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  For definitions and policies, see 41 CFR part 304-1.

				U.S. Department of Agriculture										X		REPORTING PERIOD: OCTOBER 1, 2022- MARCH 31, 2023				REPORTING PERIOD: APRIL 1 - SEPTEMBER 30, 2023				NEGATIVE REPORT

				Agricultural Research Service -Southeast Area

				Agency Contact:		Mary Sluder		mary.sluder@usda.gov

				TRAVELER 		EVENT DESCRIPTION & EVENT SPONSOR		EVENT DATE(S) [MM/DD/YYYY-MM/DD/YYYY]:		LOCATION AND TRAVEL DATE(S) [MM/DD/YYYY-MM/DD/YYYY]				BENEFIT SOURCE						BENEFIT DESCRIPTION		PAYMENT BY CHECK		PAYMENT 
IN-KIND		TOTAL AMOUNT



		EX		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE

				John Smith		Conference on Asia-Pacific Relations		8/11/11				San Francisco, CA		Asia Pacific Forum Pacific Rim Foundation 						Hotel				X		$280

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Air Transportation		X				$825

				Secretary		Asia-Pacific Forum		8/12/11		                    		8/11/2011-8/13/2011								Meals				X		$120

		1		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary Pantin-Jackwood		Conference		3/13/23				Sacramento, CA		Western Poultry Disease Conf Foundation						Common Carrier		x				$972

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		x				$100

				Res Vet Medical Officer		Western Poultry Disease Conf Foundation		3/15/23		                    		3/12-16/2023								Lodging/Meals/Registration				x		1037

		2		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michele Reba		Speaking Engagement		2/1/23				Garwood, TX		Lower Colorado River Authority						Common Carrier						$320

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Rental Car						$250

				Res Hydrologist		Lower Colorado River Authority		2/1/23		                    		1/31-2/2/2023								                           

		3		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Michael Rothrock		Conference/Symposium		3/24/23				St. Paul, Minnesota		Univ. of Minnesota						Taxi/Shuttle		x				$100

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem		x				$197.50

				Res Microbiologist		Dr. Tim Johnson		3/24/23		                    		3/23-25/2023								Common Carrier/Lodging				x		796

		4		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary Pantin-Jackwood		Conf/Speaking Engagement		1/23/23				Atlanta, GA		Southern Conference on Avian Diseases						Parking/Meals/Use of vehicle		x				$227

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		$18

				Res Veterinary Medical Officer		Southern Conference on Avian Diseases		1/24/23		                    		1/23-24/2023								Lodging				x		$163

		5		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kyoung Ro		Conference		1/24/23				GA World Congress Center		Univ. of Connecticut USDA- Sustainable Agricultural System (SAS) Poultry Grant						Lodging		x				$714

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Transportation		x				$129.80

				Res Envrnmtl Engr		Univ. of Connecticut		1/26/23		                    		1/23-26/2023								Meals/IPPE Registration		x				$309.00

		6		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Mary Pantin-Jackwood		Speaking Engagement		10/3/22				Ocean City, Maryland		Delmarva Chicken Assn.						Common Carrier		x				$253.21

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		212

				Res Veterinary Medical Officer		Delmarva Chicken Assn.		10/5/22		                    		10/3-5/2022								Meals and Meeting Registration				x		397.5

		7		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alfred Handler		Conference		10/23/22				Mount Scopus, Israel		Insect Reproductive Molecules Organizing Committee						Common Carrier		x				$500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		1260

				Res Geneticist (Insects)		Insect Reproductive Molecules Organizing Committee		10/27/22		                    		10/21-29/2022								Conference fee and Meals				x		960

		8		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alan Franzluebbers		Conference/Speaking Engagement		12/2/22				Hurrican Exacuation Center, Alexandria, LA		Louisiana Forage and Grassland Council						Per Diem		x				$160.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging		x				$210.00

				Res Ecologist		Louisiana Forage and Grassland Council		12/2/22		                    		11/28-12/3/2022								Mileage		x				$275.00

		9		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alan Franzluebbers		Conference/Speaking Engagement		11/2/22				Springfield, Missouri		Missouri Forage and Grassland Council						Per Diem and Lodging		x				$500.50

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration fee				x		$150

				Res Ecologist		Missouri Forage and Grassland Council		11/3/22		                    		11/1-4/2022								Common Carrier		x				$254

		10		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Phillip Wadl		Seminar		12/2/22				Rutgers University, NJ		Rutgers University						Per Diem		x				$174.50

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Taxi/Shuttle		x				$125.00

				Res Geneticist		Rutgers University		12/2/22		                    		12/1-3/2022								Flight/Lodging				x		350

		11		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alan Franzluebbers		Speaking Engagement		2/8/23				Lancaster County Convention Center, Lancaster PA		PASA						Lodging		x				$200.00

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Per Diem		x				$200.00

				Res Ecologist		PASA		2/11/23		                    		2/7-9/2023								Registration fee				x		100

		12		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Alan Franzluebbers		Conference		2/2/23				Wisconsin Dells, Wasconsin		GrassWorks, Inc						Common Carrier		x				$500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Rental Car/Mileage		x				$280

				Res Ecologist		GrassWorks, Inc		2/4/23		                    		2/2-4/2023								Lodging/Meals				x		$400.00

		13		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Frank Rinkevich		Conference		10/20/22				Helena, MT		Montana State Beekeeper's Assn.						Common Carrier				x		1000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		600

				Research Entomologist		Montana State Beekeeper's Assn		10/21/22		                    		10/19/2022-10/22/2022								                           

		14		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kate Ihle		Seminar		10/3/22						Department of Entomology, University of Illinois						Common Carrier				x		700

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		536

				Research Molecular Biologist		University of Illinois		10/5/22		                    		10/02/2022-10/06/2022								meals				x		200

		15		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Kim Bowman		Conference		10/18/22				Visalia, CA		California Citrus Research Board						Common Carrier and Rental Car				x		735.3

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging and meals				x		564.75

				Research Geneticist		California Citrus Research Board		10/20/22		                    		10/17/2022-10/20/2022								Airport Parking and Travel to and from airport				x		145.08

		16		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Frederick Breidt		Meeting		10/18/22				Las Vegas,NV		Pickle Packers International 						Lodging				x		605

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Microbiologist		Pickle Packers International 		10/20/22		                    		10/17/2022-10/20/2022								                           

		17		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ilenys Perez-Diaz		Meeting		10/18/22				Las Vegas,NV		Pickle Packers International 						Lodging				x		605

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Microbiologist		Pickle Packers International 		10/20/22		                    		10/17/2022-10/20/2022								                           

		18		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Gina Brown-Guedira		Seminar		10/20/22				College Park, MD		University of MD						Common Carrier				x		350

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		300

				Research Geneticist		University of MD		10/20/22		                    		10/18/2022-10/21/2022								Meals				x		100

		19		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Suzanne Johanningsmeier		Meeting		10/18/22				Las Vegas,NV		Pickle Packers International 						Lodging				x		605

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Food Technologist		Pickle Packers International 		10/20/22		                    		10/17/2022-10/20/2022								                           

		20		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joan Burke		Training		10/17/22				Kingston, Jamaica		USAID-funded Farmer to Farmer program at Partners of Americas						Common Carrier		x				1200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		1582

				Research Animal Scientist		USAID		10/29/22		                    		10/16/2022-10/30/2022								                           

		21		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Andrew O'Reilly		Conference		10/24/22				Tuscaloosa, AL		Center for Water Quality Research 						Lodging				x		288

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Registration fee				x		25

				Research Hydrologist		Center for Water Quality Research		10/26/22		                    		10/23/2022-10/26/2022								                           

		22		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Swayne		Conference		11/2/22				Medellin, Colombia		Federacion Nacional de Avicultores de Colombia						Common Carrier				x		1200

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		435

				Laboratory Director		Federacion Nacional de Avicultores de Colombia		11/4/22		                    		11/01/2022-11/04/2022								Meals				x		312

		23		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joan Burke		Meeting		11/2/22				Woolley's Classic Suites		American Lamb Board						Common Carrier		x				410

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		212

				Research Animal Scientist		American Lamb Board		11/3/22		                    		11/1/2022-11/4/2022								                           

		24		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Anthony Pokoo-Aikins		Meeting		11/30/22				University of MD		Universit of MD Eastern Shore						Common Carrier				x		1050

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		400

				Research Biologist		University of MD Eastern Shore		12/2/22		                    		11/29/2022-12/02/2022								Meals and Taxi/shuttle				x		150

		25		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Frank Rinkevich		Conference		12/1/22				Canada		Alberta Beekeeping Commission						Common Carrier				X		1000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		700

				Research Entomologist		Alberta Beekeeping Commission		12/2/22		                    		11/30/2022-12/04/2022								Conference Registration				x		150

		26		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Suzanne Johanningsmeier		Meeting		12/6/22				Grand Rapids, MI		Michigan Vegetable Council						Lodging				x		300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier		x				400

				Research Food Technologist		Michigan Vegetable Council		12/8/22		                    		12/05/2022-12/08/2022								Meals and mileage		x				272

		27		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Frederick Breidt		Conference		12/7/22				Washington, DC		Gimga Group						Lodging				x		300

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Microbiologist		Gimga Group		12/7/22		                    		12/07/2022-12/08/2022								                           

		28		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Andrew O'Reilly		Meeting		12/5/22				Silicon Valley, CA		American Water Works Assn.						Common Carrer and Taxi/Shuttle		x				530

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		490

				Research Hydrologist		American Water Works Assn.		12/7/22		                    		12/5/2022-12/7/2022								Meals and Parking				x		215

		29		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				David Shapiro		Seminar/Speaking Engagement		12/5/22				Ha Noi, Vietnam		Plant Protection Research Institute, Vietnam Academy of Ag Sciences						Common Carrier				x		2500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		700

				Research Leader		Plant Protection Research Institute, Vietnam Academy of Ag Scie		12/12/22		                    		12/5/2022-12/12/2022								Taxi/Shuttle/Meals				x		600

		30		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		31		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Hans Cheng		Conference		1/13/23				San Diego, CA		International Plant & Animal Genome 30						Common Carrier				x		500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		1000

				Research Geneticist		International Plant & Animal Genome 30		1/18/23		                    		1/13/2023-1/18/2023								Registration fee				x		845

		32		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Ted Kornecki		Seminar		1/16/23				Philippines		Kansas State University						Common Carrier				x		2500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		1200

				Agricultural Engineer		Kansas State University		1/27/23		                    		1/12/2023-1/30/2023								Taxi Shuttle/Meals				x		1600

		33		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Katie Richard		Meeting		1/3/23				Baton Rouge, LA		LSU Foundation						Lodging				x		350

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		100

				Agricultural Science Research Technician				1/5/23		                    		01/02/2023-01/05/2023								                           

		34		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Annie Donoghue		Meeting		2/13/23				Atlanta		Denise Beeland Quick University of GA/SARE Program						Lodging/Taxes		x				391.09

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals		x				172.5

				Research Leader		University of GA		2/15/23		                    		2/13/2023-2/15/2023								Parking/Mileage		x				1028.75

		35		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Joan Burke		Meeting		2/13/23				Atlanta, GA		SARE						Lodging		x				326

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Common Carrier		x				600

				Research Animal Scientist		University of GA		2/15/23		                    		2/13/2023-2/15/2023								Taxi/shuttle/parking		x				81

		36		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Melissa Smith		Speaking Engagement		2/23/23				Pullman, WA		Washington State University						Common Carrier				x		900

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Ecologist		Washington State University		2/24/23		                    		2/23/2023-2/26/2023								                           

		37		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Jim Holland		Conference		2/16/23				College Station, TX		Texas A&M University						Common Carrier				x		600

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		400

				Research Geneticist		Texas A&M University		2/17/23		                    		2/15/2023-2/18/2023								Meals/taxi/shuttle				x		350

		38		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Zamir Libohova		Conference		2/6/23				Orleans, France		Le STUDIUM, Institute for Advanced Studies						Common Carrier				x		1500

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging/Meals				x		1100

				Research Soil Scientist		Le STUDIUM, Institute for Advanced Studies		2/10/23		                    		2/4/2023-2/12/2023								Taxi/Shuttle/Registration				x		500

		39		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Chandrasekar Kousik		Meeting		2/15/23				Durham, NC		Mississippi State University						Lodging				x		350

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Leader		Mississippi State University		2/16/23		                    		2/14/2023-2/17/2023								                           

		40		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Richard Mankin		Conference		2/27/23				King Abdullah University		KAUST Research Translation and Partnerships Office						Common Carrier				x		6000

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		1600

				Research Entomologist		KAUST Research Translation and Partnerships Office		3/2/23		                    		2/25/2023-3/1/2023								Taxi/shuttle/meals				x		752

		41		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Melissa Smith		Speaking Engagement		2/24/23				Pullman, WA		Washington State University						Common Carrier				x		900																		Washington State University

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

				Research Ecologist		Washington State University		2/24/23		                    		2/23/2023-2/26/2023								                           

		42		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Frank Rinkevich		Conference		3/24/23				Broken Arrow, OK		Northeast Oklahoma Beekeepers Assn						Common Carrier				x		500																		Northeast Oklahoma Beekeepers Assn

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging				x		400

				Research Entomologist		Northeast Oklahoma Beekeepers Assn		3/25/23		                    		3/23/2023-3/26/2023								                           

		43		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Matias Vanotti		Meeting		3/6/23				Taiwan		Taiwan Council of Agriculture						Common Carrier				x		7233																		Taiwan Council of Agriculture

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Lodging/Meals				x		1200

				Research Soil Scientist		Taiwan Council of Agriculture		3/8/23		                    		3/3/2023-3/11/2023								Local Transportation				x		328

		44		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

				Wayne Hunter		Other - receiving award		3/10/23				Lakeland, FL		FL Academy of Sciences						Lodging				x		219																		FL Academy of Sciences

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										Meals				x		45

				Research Entomologist		FL Academy of Sciences		3/10/23		                    		3/9/2023-3/11/2023								Registration fee				x		45

		45		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		46		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		47		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             

										                    										                           

		48		TRAVELER NAME		EVENT DESCRIPTION		BEGINNING DATE [MM/DD/YYYY]		LOCATION				BENEFIT SOURCE						                              

																				                              																								0

				TRAVELER TITLE		EVENT SPONSOR		ENDING DATE [MM/DD/YYYY]		TRAVEL DATE(S)										                             
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